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Section

1 Getting started

The Asure ID® User Guide covers the basics of the Asure ID user interface, installation, and configuration. For
a more in-depth explanation of Asure ID, see the Asure ID Reference Guide (PLT-01797). This reference guide
can be downloaded from the HID Global® web site http://www.hidglobal.com/documents.

1.1 Supported OS and database engines
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Supported Operating Systems
Windows 7 (32-bit and 64-bit)
Windows 8 (32-bit and 64-bit) .
including Windows 8 Pro Tablets All Asure ID Editions
Windows 10 (32-bit and 64-bit)
Supported Database Engines
Microsoft Access (2000 and Native | Native, Native, Native, Native
2002/2003) Live Link | Live Link | Live Link
SQL Server (2000, 2005, 2008, Native, Native, Native
2012, 2014, 2016, and 2017) Live Link | Live Link
Networkable' X X
MySQL (version 5) Live Link
Oracle (9i and 119) Native, Native
Live Link
Microsoft Active Directory / LDAP Live Link
ODBC Live Link

1. Asure ID site license enable sharing of networked database information on multiple workstations.
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1.2 System requirements
m 1 GHz or faster processor
= 1GBRAM
= ] GB available hard disk space
m  Supported operating systems

1.3 Installation
The Asure ID installation files can be accessed in either of the following:
= The Asure ID CD. Insert the CD into the PC and follow the instructions.
Note: If the CD does not run automatically, browse to the Setup.exe file.

= Download the software from the HID Global web page, www.hidglobal.com/AsurelD.

1.3.1 Installation wizard
1. The Installation Wizard opens and starts the installation.
2. Select a language from the pull-down list, and click Next.

Note: To install the software in Indonesian you download/install the English version of Asure ID, then
use the Change Language option to change the program to Indonesian. See Section 2 The
Options window.

Welcome to Asure ID Setup

The InstallAware Wizard will install Asure 1D on this computer. Please
select an installation language and dids Next to continue.

English =

3. Read and accept the License Agreement, and click Next.
4. Select a folder to install the software, and click Next.
5. When installation is complete, Set the Installation Options:

= Activate Asure ID - With a license key you can activate the Asure ID software. If this option is not
selected, Asure ID is installed with a 30-day trial license. See Section 1.3.2 Activate Asure ID.

= Configure Native Data Source - Allows you to configure the native data source which stores card
templates and Asure ID system information. By default Asure ID sets the native source to an
embedded Microsoft Access data source.

Note: This option is recommended for installations where Asure ID is used on multiple PCs, where all
template and reporting information needs to be consistent.

= Automatically Check for Updates - Notifies you of product updates.
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6. Click Finish.

Asure ID Setup Complete

Asure ID has been installed successfully.
Collecting information
Preparing installation

Installing Installation Options

Finalizing installation

? i atically check for updates

Run Asure ID

NOTE: The User ID and Password to use on first use is
"admin".
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1.3.2 Activate Asure ID

If Activate Asure ID is selected, Asure ID prompts you to enter the following information and the license key.

Note: The license key is located on the back of the CD case.
1. Click Phone Activation or Activate Online.
Note: Online activation requires an Internet connection.
2. Click OK.

Note: If Phone Activation is selected, you are directed to call a provided number and provide this
information to HID Global.

Activate License

First Mame: John

Last Mame: Doe

Email; 1jdoe @hidglobal, com
Company Mame: HID Glabal

State [ Province: co

Couniry: Lisa

Frinter Make | Model: Printer Model

License Key: AANNN-AAAANANA

|| Subscribe to product newsletter

|¥| Subscribe to anonymeus surveys

! Phone Activation | | Activate Online [

Asure ID
System License: None
License Level: Trial

Additional Licenses:

| Close
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1.4 Initial login
1. Open Asure ID by double-clicking the Asure ID icon.

&

Asure ID

Note: If the software has not been activated the Activation Required window opens. Select a version of
Asure ID. Click Activate. For a 30 day trial version, click Continue.

Activation Required
| * Activation i required o use thes product. Once & bcense has been actvated on a

| computer, it cannot be used an another computer. By Activabng this beense you will lock it
to the current computer.

I
To start the actvation process, didk on the Actvate button. To continue using this product
during the brial period, select 8 version below and didk on the continue button.,

Versiom:  Exchangs . Trial Period
Days Lafh 30

«é Actrvbe h Continue

2. For Asure ID Express editions and above, enter:

User ID: admin
Password: admin

Note: Asure ID Solo users are not required to enter a user ID or password.

Note: To identify the Asure ID edition purchased, see the Licensing window (File > Options >
Licensing). The edition is displayed under the Asure ID section with the license key.

3. You can modify the Starting Application option if needed.

4. Click OK.
Login

User ID: admin

Password: T

Starting Application: Card Design -
[CardDesan

I oK Data Entry

Reports

| Work Order Manager
Key Management

| Reader Configuration
|User Config

| Laser Config
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1.5 Window layout of Asure ID

With each Application that is selected there is a corresponding set of tabs, tools and display screens. Each of
these Application windows are described in detail in the following sections.

[ - B Card Design - Asure 1D = =
Pz Card Setg Wen Lases a gl
D T By wl B \NAG@E I ~navnea

CiA Copry  Paome | Tewtisbsel DawsPod Cospound . Fhaly Sonatre [mape Badiground Line - Polyirse Eipie -« Rectanghs Earesds [ all. mn:;’;ﬂl o
Feid -
Teal Imaging 1l hiames A imds (=0 2
F T T E = P . s
-
o
— =, S
-
)
[7/] i ] )
g =" (7]
= *_I
] Data By 71
5 =
g e
i
Card Template
a LASS IE Encoder e
£ Advanced

m ] CGard Front |
. ﬂ ] e T

|' =

| I |
Current Cursor Card View &
Location Zoom Control

Applications: This side panel contains all the applications modules used to design, create and manage
security issuance cards. See Section 1.5.71 Asure ID application modules.

Card Properties: When accessed, the data fields of the cards (Data Field tab) as well as Smart Chip
Applications (iDIRECTOR® tab) are displayed.

Current Cursor Location: The X/Y coordinates show the current position of the cursor. If rulers are displayed,
the markers also show this position.

Card View & Zoom Controls

= Card View: You can toggle between showing both sides of the card and either front or back. These
views are only enabled if the card is dual-sided.

= Zoom Controls: You can zoom in and out as well as set specific zoom levels.
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1.5.1 Asure ID application modules

1.5.1.1 Home

= Card Design enables you to create a card template for each card type (for example, employee card,
contractor or student).

= Data Entry allows you to add, modify, and delete card records, including acquiring photos and printing
cards.

= Reports allows you to view standard reports (for example, user activity and template activity reports)
and custom reports.

1.5.1.2 iCLASS SE encoder

The iCLASS SE Encoder application allows you to create work instructions and embed them into a template.
= Work Order Manager
n  Key Management
=  Reader Configuration

1.5.1.3 Advanced

= User Config - Allows you to manage user privileges and login credentials for Asure ID Editions of
Express and above.

= Laser Config - Allows configuration of numerous laser settings.
Note: With the Asure ID internal database, you can store card templates and cardholder information.

Note: With Live Link, you can also print card data from external databases such as HR, security or ERP. The
Live Link wizard sets up real time data exchanges with a few mouse clicks. At print time, Live Link
accesses and delivers the data that populates the external data fields on each card. For detailed
information on the Live Link, see the Asure ID Reference Guide (PLT-01797).
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Section

2 The Options window

The Options window is available on every File tab, and allows you to manage the iCLASS SE® Encoder
Formats, Plugins, Database, Options, and User Options.

—
|

File

T e B T A=

Mew Template Recent Templates

Open Template

Close Template

&5 |

[E

Save Template

Save Template As

Options )
Language | Choose a Language

Bind Template s
. e wll dgyell aSlondl) au =i}

Skins Ceiting (Ceska republika)

Import/Export ¥ Resources Deutsch (Deutschland)

Espariol (Espana, alfabetizacion internacional)

Manage Templates

Do §elE

o T . Printng Francais (France)
Pesyenw Teiophme Advanced Printing Bahasa Indonesia (Indonesia)
. Ercosing F'l:lr‘tIJgL.I'ES (Brasil)
Print Template Pycormil (Pocoisa)
Licensing Ty (L)
: | oo Py el A R TIE)
gvices

ICLASS 5E Encoder

QK | | Cancel
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2.1 Configurable options

The Options window has the following configurable sections. For detailed information on each option, see the
Asure ID Reference Guide (PLT-01797).

Options
| Language | Choose alanguage
Template English (United States)
: g wll Aurpell aSlondl) G peli}
Sking Cestina (Ceska republika)
Resources Deutsch (Deutschland)
o Espariol (Espania, alfabetizaddn internadional)
Printing

Frangais {France)
Advanced Printing Bahasa Indonesia (Indonesia)
Portugués (Brasil)

Encoding Pycoxult (Pocaan)
Licensing ‘Ivn (ng)
Card Design Yorkgs (Turkdye)

ghrr (Hhie A R HFOE])
Devices

iCLASS SE Encoder

| oK | | Cancel |

= Language: Allows you to set the default language of the application.

= Template: Allows you to set the basic template options for the Asure ID application.

= Skins: Allows you to customize the look of the Asure ID application by selecting a predefined skin.
= Resources: Allows you to access resource information for the application.

= Printing: Allows you to define all of the printing options for the application.

= Advanced Printing: This option is used to configure the printer chip encoding and magnetic encoding
command sequences. The parameters auto-fill for the selected printer.

= Encoding: Allows you to manage all the encoding settings within the printer.
Note: There is a desktop encoder available, that allows you to encode cards with a separate device.

= Licensing: Allows you to view, modify, and activate the licensing information of the Asure ID
application.

= Card Design: Allows you to set the Card Design default settings for the text labeling, field formatting
and compound field formatting.

= Devices: Allows you to select from available Photo and signature devices.
= jCLASS SE Encoder: Allows you to modify iCLASS SE Encoder options on the Asure ID application.
Note: This option has multiple tabs; Format, Plugins, Database, Options, and About.
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Section

3 Card Design application

The
[ ]
[ ]

The

Asure ID Card Design application allows you to:
Lay out and design a card template.
Add technologies, including a barcode.

Personalize the work environment, including adding and removing grid lines and rulers as well as
modifying the card view, orientation, zoom level and properties.

Link data fields to external data sources.
Save, edit and export work.

Card Design application is used to create the card layout for printing and encoding. Each card layout is

saved as a template for use by the Data Entry application.

Important: After the template is saved with the links to the data source, you cannot add additional fields.

The existing fields can be modified, but if a new field is needed, a new template needs to be
created.

For detailed information on the Card Design application, see the Asure ID Reference Guide (PLT-01797).

i =] & Card Design - Asure ID =
File H CardSetup Vi L % @
| ome ard Se e aser
‘i |_E Tahl T bt " T E = ¢ Signature \ ¥, Polyline ["I ”u |aligr: = | T Hn = el | I
: = | | =] & |-+ = 3
e = I Image @ Elip== |Center: & 2
Cut Copy Paste Textlabel DataField Compound | Photo Line Barcode |
Field =2 Background Ml Rectangls Select All: & |
Clipboard Text Imaging Shapes Barcode Editing
L LW R R R
| i Home |n_- .~ - Figld Mame A
B » | B4 Mon-Printable Fields
@ ] | Print By
o 2 | Print Count
Card Design ]
- i . =] Print Date
‘_I 1 = L. &7 Printable Figlds
E= i
Data Entry ]
Reports ]
\,
| ©)icLASS SE Encodar a
| € Advanesd [l 1
m i - Data Fields RECTOR
|(-16.0, 138.9) Pixels = | L:';. EHIE &, 100% -~ Q.@
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3.1 Card Design overview

The Card Design application has the following tabs, with a corresponding toolbar.

- : Home Card Setup View Laser ES -&!“
RO T &g v 374 = \NGO W Il wearusw|

8§ Fingerprint
Cut Copy Paste | TextlLabel DataField Compound —Photo Background Line Paolyline Hipse Rectangle | Barcode | |Center: - Je |Iselect all: 1@ |
Field - Image - i

Clipboard Text Imaging Shapes Barcode Edditing
= File: This tab allows you to perform template operations.
= Home: This tab contains all the tools to create/modify a card template.
= Card Setup: This tab displays the current card layout, and additional tools for card configuration.

= View: This tab allows you to display and modify the current view.

3.2 Basic Card Design tutorial

The tutorial walks through the process of creating a basic ID card. From this example, you should be able to
create their own templates, import data, and print cards.

The basic Card Design is as follows:
m  Section 3.2.1 Create a template
m  Section 3.2.2 Add a text label (company name)
m  Section 3.2.3 Add a data field (employee number)
m  Section 3.2.5 Compound field (last name, first name)
m  Section 3.2.6 Add a photo
m  Section 3.2.8 Add image (logo)
m  Section 3.2.7 Add a signature

Additional capabilities, such as magstripes, barcodes and Smart Chips are covered in Section 3.3 Advanced
card design tutorial.
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3.2.1 Create a template
Note: For detailed information on Card Design see the Asure ID Reference Guide (PLT-01797).

1. Select Card Design applications > File tab > New Template.

Card Design - Asure ID =

R s 9

| D Recent Templates YN O Wl e e T m =

New Template
Line Polyline Elipse Rectangle  Barcode | |center: & e ||select All: =

\j} T Shapes Barcode Edifing
1 e e o e
Close Template |
| 2
|| g a
H Save Template Y =
&

Save Template As

Manage Templates

oI E §&E

Bind Template

Import/Export ¥

Preview Template

Print Template

Options | | Bt Asure ID

(2.9, -15.3) Pixels ~ | = BT & vz o‘@l

",

Card Front
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2. Select Create New Template.

Note: Selections are indicated with an orange background and selected options are displayed in the
Card Properties pane.

‘New Template ==
Templates 1. Select Card Size and Mumber of Sides

[Q-_eateNewTemplat: i " =] ™ — ™
Sample Gallery [_‘:J g Iﬂ j I‘_J [__J

= =

Single Sided  Dual Sided Single Sided  DualSided Sngle Sided Dual Sided

CR-80 CR-80 CR-79 CR-79 Custom Custom

2. Select Card Orientabion
== [

Landscape Portrait

3. Select Magstripe Properties Card Properties
D ﬁ Card Size: CR-80
Double Sided: No
Orientation: Landscape
None Magstripe
Magnetic: No
Technologies: None
4. Select Technologies
"} None
Prox (OK5125)
ICLASS (OK5121)
T MiFare (OK5121)
CP1000 (OK5127)
' Command Line

oK Cancel

3. The window displays each step to create a new template. Set the following options:

Field Setting

Select Card Size and Number of Sides Single Sided CR-80
Select Card Orientation Landscape

Select Magstripe Properties None

Select Technologies None

Note: The selected options are displayed in the Card Properties pane.

4. Click OK. The new template opens in the display window.
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5. Select File tab > Save Template. Enter a Name for the template and click OK.

‘Save Template =

Available Templates:

Template Mame:
Template_1]

6. The template name displays on the top of the window, and the card information and view controls are
at the bottom of the window.

[ [} > l Card Design - Template_1 - Asure ID I -

x
E Home Card Setup View " |
dBD T B «% &’5‘""“ = \N@ g W spsvaza

@ Fingerprint

Cut Copy Paste Textlabel DataFeld Compound | Photo Background Liné  Polyline Elipse Rectangle | Barcode | |Center: & e ||select All; i
Fiedd e . o
Chpboard Text Imaging Shapes Barcods Editing
P ! = | A Fﬁ ol | = g2
= -
o
F | r N 2
s ®
Card Desion
Data Entry
Reports T

HID E § J | cardFront

|(172.5, 87.0) Pixels -

Note: You can adjust the view displayed from the View tab options.
E Hame Card Setup Laser

| e |Ruser Units; Pixels = q‘ Q‘ TN
| = |J j . st e @ - | |:| o =&

5nap T0 |Snap Size: 10,0 - | Preview | FtCard Zoom In Zoom Cut || Gridlines RJ.LIers Card Smart
Grid Mads || In View Properties Chip
Woarkspacs Zoom Show Hide
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3.2.2 Add a text label (company name)

A text label prints the same on every card. There is no data entry or database that feeds into this field. For
this example a Company Name is added.

1. Select Card Design application > Home tab > Text Label.

E Home Card Setup View Laszer e

- = = Text Label
w P
& u j E | T = "T Figld Mame:  Company Mame
Cut Copy Paste  [extlabel Qata Field Compound Field Text: HID Global
Field
Clipboard Text
Fant Alignment
FontName:  Arial Black * Harizontal | =11 ..|
Font Color: | I Black i verticat [ |51 IiD_!
" :___|;___- _i
Font Height: |14 Rotatio 0
O i

FontStyle: | B rjufs | {In dearees COW)

Options Placement

L Yot Wi Left: 1898 | idth:| 157.1 3
[¥] Awto Size

[ b B Top: 1184 5 Height: | 3842
Prirting Border and Fill

[} Non-Printable Entry Border Color: | 1 Transparent -
[T Conditional Border VWidth: {1 S
1 Print on Fluariscing Panel Fill Calor: | ] Transparent

| oK | | Cancel

2. Click in the Card Display pane to open Text Properties and set the following:

Field Setting

Text Label Define the field name and enter the text to display in this field.

Note: The Field Name should be a name that can be associated to the actual field text.
Field Name: Enter Company Name

Field Text: Enter your company name (example is HID Global).

Font Set the font options. In this example the following was set:
Font Name: Arial Black

Color: Black

Font Height: 14

Font Style: No selection was made.

Alignment Select alignment options. In this example both options were set as Center.
Options Select the following options as needed. In this example Auto Size is selected.
Word Wrap

Laser Engrave
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Field Setting
Placement Enter a specific location for the label. The text box can be moved using drag/drop.
Printing Select the following options as needed. In this example no options were selected.
Non-Printable Entry, Conditional, and Print on Fluorescing Panel
Border and Select the following options as needed. In this example the following was set:
Fill Border Color: Transparent
Border Width: O
Fill Color: Transparent

3. Click OK and Save (File tab > Save Template).

3.2.3 Add a data field (employee number)

The data field adds a unique data field to the card record (i.e. employee number). See Section 4 Data Entry

application for information on populating the Data field.

1. Select Card Design application > Home tab > Data Field.

-' | e
& D

Cut Copy Paste

Clipboard

September 2018

Card Setup Wiew Laser

TextLabel Pata Field Compound
Figld

Teet

Data Field Properties
Data Field
Field Mame: | Employee Number
Advanced Data Field Options
Field Options
[] This is a Unigue Field

[¥| This is a Mandatory Field

Font
Font Mame:  Arial
Font Color; | I Black
Font Height: |10
Font Style: |?I ; |E|;|
Options

[T} Word Wrap

Laser Engrave
Printing
[l Mon-Printable Entry

I7] Conditional

Field Type:
1 Text

o List

' Date

1 YesfMo
) Mumeric

Alignment
Horizontal: |_|:|__||EH E|
s VD)

-

Rotation: ¢l
{In degrees CCW)

Placement
left:| 97.3 % Width:| 95.0
Top:| 63.7 | Height: 240

Border and Fill

Border Color: | ] Transparent

Border Width: 0

Fill Color: | ] Transparent

! OK | | Cancel
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2. Click in the Card Display pane to open Data Field Properties, set the following:

24

Field Setting
Data Field Define the field name and enter the text to display in this field.
Note: The Field Name should be a name that can be associated to the actual field text.
Field Name: Enter Employee Number
Field Type: Text
Field Options: This is a Mandatory Field
Font Set the font options. In this example the following was set:
Font Name: Arial
Color: Black
Font Height: 10
Font Style: No selection was made.
Alignment Select alignment options. In this example Both options were set as Center.
Options Select the following options as needed. In this example the option Reduce to Fit is
selected.
Placement Leave whatever data is populated. The text box can be moved using drag/drop.
Printing Select the following options as needed. In this example no options were selected.
Non-Printable Entry, Conditional, and Print on Fluorescing Panel
Border and Select the following options as needed. In this example the following was set:
Fill

Border Color: Transparent
Border Width: O
Fill Color: Transparent
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3. Click Advanced Data Field Options.

Note: The Advanced Data Field Options window shown below is for a Data Field that has the Field
Type of Text selected. For information on other Field Types Advanced Data Field Options, see
the Asure ID Reference Guide Section 3 Card Design Application (PLT-01797).

Data Field Properties
Data Field
Figld Mame:  Employes Number Field Type:
‘ Advanced Data Field Options ' .
B0 Text
Field Options “List
| This is a Unique Field & - = =
~| Advanced Data Field Options
[¥| This is a Mandatory Field 3 Text Optians Data Source
Fant Alignment Default Value: HID Glohal - Source: i_;_:_é‘_' e |
Font Name: | Arial Horizontd Max Characters: 0 Table:
Font Calor; | HEM Black £ Verticd Min Characters: 0 Field:
FroEEieayt 2 — Rotatio Format: Mone -
FontStyle: | B 7| u|s |
e Picklist Data Formatting
Options Placement ] pref
= [T Use a picklist to select the value DfiErene
1T} Word Wrap . s
Left: =
O] Suffix
_ : | Force Case
|| Laser Engrave L
Printing Bta s A il Cl Fill Unused Leading Space With
- | Fill Unused Trailing Space With
|| Non-Printable Entry Border Ci
il iti Border Wif
fandiinl j Diata Entry Options
[ Print on Fluorescdng Panel Filcq
| |
ak | | Caneel |
4. Set the following:
Field Setting

Text Options Set the following Text Options:

Default Value: Enter a default value (in this example we entered HID Global - ). This
displays on all cards prior to any data entered during Data Entry.

Note: This field is not required.
Max Characters: 20
Min Characters: O
Format: None

Data Source

Source: Data Entry

Picklist

No options selected.

Data Formatting

No options selected.

Data Entry Options

No options selected.

5. Click OK to close the window.

6. Click OK to close the Data Field Properties window.
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7. The newly created Data Field can be positioned on the card, by simply selecting and dragging.

™ _B ,_* Card Design - Template_1 - Asure ID - x
E Home Card S=tup View Laser 2 @
SEETE 1 b £ Sgaure g - =
d 20 T EHedr | &40 \NG g I wzswn=a
Cut Copy Paste | Textlabe DataField Compound = Photo _ ackground e Polyline Elipse Rectangle | Bartode | Center: B e |select Al I
Field B -
Cipboard Text Imaging Shapes Barcods Editing
_| | =) — g |‘“. roa | i |ﬁ PR e Gl F 1 |'°° Q
(=3
| 4 Home | 2
- I '8 L g-
@ :
:.zr-:l:'.'ng] HID GIObaI
Data Entry
Reports T3
|55 LSS SE Encoder |
| € Advanced |
1l K<Employee Number>>
m 1 Card Front
200
(3.6, 208.6) Pixsls ~ ElE=L N Qs

8. Select File tab > Save Template.
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3.2.4 Add a data

Card Design application

field picklist (employee dept.)

The Data Field Picklist allows you to select a requirement from a list. See Section 4 Data Entry application for
information on populating the Data field.

1. Select Card Design application > Home tab > Data Field.

d 2B T

Cut Copy Paste

Clipboard

Card Setup View Laser Data Field Properties
Data Field
=4 : T Field Name: Employee Dept.
Text Label |Data Field JCompound Advanced Data Field Options
Field Field Options

[ This is a Unique Field
[T This is a Read-only Field
[Tl This is a Mandatory Field

Fant
Font Mame:
Font Color: I Black
Font Height: 10
Font Style: |?i ; IE|;|
Options

11| Word Wirap

[¥] Reduce To Fit

I Laser Engrave
Printing

[ Non-Printable Entry
|T]] Conditional

[ Print on Fluorescng Panel

Field Type:
B Text

~ List

~ Date

7 Yes Mo
1 Mumeric

Alignment
Horizontal: |E"ﬁii E|
Vertical: |;|i|__||g||-|§|-|
Rotation: 4
{In degrees CCW)

Placement
Left:  80.0 & Width:

Top:| 813 . Height:

Border and Fill

Border Color: | [ Transparent

Border Width:

Fill Calor: | ] Transparent

9.0 *

4.0 :

koo |

Cancel

2. Click in the Card Display pane to open Data Field Properties, set the following:

Field

Setting

Data Field

Define the field name and enter the text to display in this field.
Note: The Field Name should be a hame that can be associated to the actual field text.

Field Name: Enter Employee Dept.
Field Type: Text
Field Options: Do not select any options.

Font

Set the font options. In this example the following is set:
Font Name: Arial
Color: Black
Font Height: 10
Font Style: No selection was made.

Alignment

Select alignment options. In this example Both options are set as Center.

Options

Select the Reduce to Fit option.
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Field Setting
Placement Leave whatever data is populated. The text box can be moved using drag/drop.
Printing Do not select any options.

Border and Select the following options as needed. In this example the following was set:
Fill Border Color: Transparent

Border Width: O

Fill Color: Transparent

3. Click Advanced Data Field Options.

Note: The Advanced Data Field Options window shown below is for a Data Field that has the Field Type
of Text selected. For information on other Field Types Advanced Data Field Options, see the
Asure ID Reference Guide, Section 3 Card Design Application (PLT-01797) .

Data Field Properties
Data Field
Field Mame: Employee Dept. Field Type:
i c i S s
( Advanced Data Field Options ) 0 ek
Field Options T List
[1] This is & Unigue Field _ Date
[ This is & Read-orly Field "'| Advanced Data Field Options
[~] This is a Mandatory Field . -
Text Options Data Source
Font Alignment e
Default Value: Source: |k Data Entry m
Font Name: Horizontd
Max Characters: 255 = Table:
Font Color: Verticd
Min Characters: e ield:
FontHeight: 10 - } WE R TR TS % Field
=————iemd Rotation]
Font Style: | B i I | u | 5 | Format: Mone -
Options Placement Picklist Data Formatting
] Word Wirap Left: [¥] Use a picklist to select the value L Prefix
[¥] Reduce To Fit [ suffix
[ Laser Engrave t Top: [&] Allaw null picklist value | Force Case
Printing Border and Fill I Allow typing value in Data Entry. [ Fill Unused Leading Space With
[=] Nan-Printable Entry Border Co [ Fill Unused Trailing Space With
. ) Manage the Picklist
IF1] Conditional Border Wi
[ Print on Fluoresdng Panel Fil €9 Data Eniry Options
|| Mask Password Characters
|
OK | | Cancel |
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4. Set the following:

Note: Set the Picklist options first, to enable the correct Default Value field.

Field Setting

Text Options Set the following Text Options:
Default Value: <NULL>
Max Characters: 255

Min Characters: O

Format: None

Data Source Source: Data Entry

Picklist Select the following options:
Use a picklist to select the value
Allow null picklist value

Data Formatting Do not select any options.

Data Entry Options | Do not select any options.

5. Select the Manage the Picklist link.
6. Click Add an Item.

7. Enter Human Resources into the field, and click OK.

Choase The Picklist

Add Picklist Item

Human Resaurces|

l| OK |I Cancel |

Remove selected item

Clear all items

| 0K | | Cancel |

8. Repeat this process entering Engineering and Finance to the picklist.
9. Click OK.
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Note: These new items now appear in the drop-down menu for the Default Value field.

Choose The Picklist ‘Advanced Data Field Options el
. Add anitem Text Options Data Source
( .
Engineering Default Value: L Source: | i Data Entry ™
Finance Max Characters: sty Table:
Human Resources
Min Characters: Engineering Field:
Format: :.FlrIElij
Picklist Data Formatting
Remove selected item [ prefi
: [¥] Use a picklist to select the value (=
Clear all items =5
[ suffix
I| oK |I| Cancel [] Allow null picklist value [ Fores Casa

Fill Unused Leading Space With
Fill Unused Trailing Space With

|7 Allow typing value in Data Entry

Manage the Piddist

Data Entry Options
|| Mask Password Characters

0K || Cancel
10.Click OK to close the Advanced Data Field Options window.
1. Click OK to close the Data Field Properties window
12. The picklist does not display in the Card Design Application.
13. Position the field on the card design area approximately where shown.
'™ &1 4 @ Card Design - Template_1 - Asure ID - B8 x
ﬁ Home Card Setup Ve Laser = ;’
Jb I:"_‘lf"' T & W &/Ij‘""" Rl \’\C o W sz
Cut Copy Paste | Textliabel I:\ata_.Fud Compound || Photo w.,-[mgemml Background line Polyine Eipse Rectangle | Barcode | |comimr: & f8 selectad: @
Field = Image -
Clipboard Text ]m.ag.v_g Shapes Barcods Editing
P e T R DN . [ T . A
- & N i
1 a

HID Global

Data Entry

P

Reports o]

||| %= CLASS SE Encoder |

| &) Advanced [
<<Employee Number>>

<<Employee Dept.>>

‘HID | W\ | cardFront

((396.2, -23.4) Poxeis - L._H = G;Tgé;h_-'ﬂg@

14.Select File tab > Save Template.
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3.2.5 Compound field (last name, first name)

A Compound Field is useful when multiple data fields are to be aligned next to each other. An example of
using a Compound Field is placing a last name one space after the first name.

1. Select Card Design application > Home tab > Compound Field.

Home Card Setup View Laser Compound Field Properties @

Compound Feld Actions

i | i = A = r
& |—! L,'-|j=| T EE:: = -. : T Field Mame: Full Name Insert data fickd

Insert existing data field
Cut Copy Paste | Textlabel Data Field) Compound | |
Field

Clipboard Text
Feld Text

Font Alignment
Font Name:  Arial - Horizont: (IEHEHIE]
Font Color: I Black - verticak: [[=] El I:I
Font Height: |10 : | Rotation: o=
Font Style: | 8| 7 [ U |5 (in degrees CCW)
Options Placement
oo Wop teft:| 3232  width: 960 °
Laser Engfavel Top:| 77.1 . Height: 240 °
Printing Border and F
MNon-Printable Entry Border Color: [ Transparent
Conditional Border Width: o:
_| Print on Fluoresdng Panel P Colar: | [ Transparent

I 0K | | Cancel

2. Click in the Card Display pane to open Compound Field Properties, set the following:

Field Setting

Compound Define the field name and enter the text to display in this field.

Field Note: The Field Name should be a name that can be associated to the actual field text.
Field Name: Enter Full Name

Field Text: This field auto-populates after the data has been entered.

Actions Click Insert Data Field to add data to the field.
Click Insert Existing Data Field to use a existing data field set up on the card template.

Font Set the font options. In this example the following was set:
Font Name: Arial

Color: Black

Font Height: 10

Font Style: No selection was made.

Alignment Select alignment options. In this example Both options were set as Center.

Options Select the Reduce to Fit option.
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Field Setting
Placement Leave whatever data is populated. The text box can be moved using drag/drop.
Printing Do not select any options.
Border and Select the following options as needed. In this example the following was set:
Fill Border Color: Transparent

Border Width: O

Fill Color: Transparent

3. Select Insert Data Field.

'Compound Field Properties =]
Compound Field Actions
Field Name:|Ful Name Insert data field
Insert existing data fi% — g
Data Field Properties
Field
Field Text ( Field Mame: First Mame ) Field Type:
Field Options 5 Text
| Thisis a Unigue Field List
This is a Read-only Fisld Date
E = | This is a8 Mandatory Field 71 Yes Mo
ont Alignment
. Eont Sett Mumeric
Font Name: | Arial - Hortzont: I=HISH i
Font Color: M Black a verticat: [C1[5]|||  Text Options Data Source
FonE g 10 Rotation: Default Value: Data Entry |l
Font Style: | B | F U s - ————
- l | =i (ndegrees| pyay characters: 255 Table:
Cptians Placement : -
Min Characters: 02 Field:
Word Wrap Left:| 32.3 7
Z Format: Mane -
Laser Engrave Top:| 77.1 % Hel | picklist Data Formatting
Printing Border and £ ] Use a pickiist to select the values L] Prefic
Mon-Printable Entry Border Color: [ Transy | Suffix
Conditional Border Width: I Farce Case
| Print on Fluoresdng Panel Fil Golow:| 1 Trans | Fill Unused Leading Space With
| Fill Unused Trailing Space With
) oK
Data Entry Oplons
| Ok | [ Caricel

4. Set the following on the Data Field Properties window:

Field
Field

Setting

Field Name: Enter First Name
Field Type: Text
Field Options: Do not select any options.

Text Options Set the following Text Options:
Default Value: Leave blank.
Max Characters: 255
Min Characters: O

Format: None

Data Source Source: Data Entry.

For information on adding a database source, see Section 4 Data Entry application.
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Field Setting

Picklist Do not select any options.
Data Formatting Do not select any options.
Data Entry Options | Options disabled.

5. Click OK.
6. Repeat steps 3, 4, and 5 with the Field name entered as Last Name.

7. Enter a space between the first and second data fields, on the Field Text display pane. If this is not
done, when the data is entered the two text fields are continuous.

':Cdmpound Field Properties

Compound Field Actions

Field Mame: |Full Name Insert data field
Insert existing data field

Field Text
| =<First Name=> <<Last Name=> |
Font Alignment
Font Name:  Arial A o “:| " ”D |
Font Color; | I Black - Vertical: ||:| irl:' |i|:| i
Fant Height: |10 - e ——
Rotation: 0

Font Style: |EIEI_£_IE| (In degrees CC':"J'}

Options Placement

~| Word Wrap Left:| 3233 Width: 96.0 -

aser Engrave Hirs Topi| 7712 Height: 240 o
Printing Border and Fill
[C] Non-Printable Entry Border Color: | [ Transparenit &
[Z] Conditional fit Coridit Border Width: 0
[™] Print on Fluorescing Panel Fill Color: | ] Transparent o
| Ok | | Cancel
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8. Click OK. Position the field on the card design area approximately where shown.

Card Design - Tempiate_1 - Asure ID =R
Fie Homee Card Sehup iew Lasser =@
i Ay " £ Sgnsure = O - 1
b T & o 4 = \N@ @ MW wzarnza
Cut Copy Paste | Textlabel DstaField Compound || Phats _ Backyound  Lne Poliine Efpse Rectangle | Barcode  |Cenuer: i B (Select Ml
Fasid s Imags . el
Cipboard TFeat Lisgng Shapes Bacnde Eckting
I S . A R . A R . S =
I ]
i f Ny §
®
HID Global
- <<Full Name=>>
I 4
|
3 <<Employee Number=>>
<<Employee Dept.>>
o - ) card Front
(816, -22,1) Puesis» | L_ | = & e G =

9. Select File tab > Save Template.

3.2.6 Add a photo

The native database for Asure ID has a size limitation of 2GB when using Microsoft Access (MS Access
limitation). Large photo files may cause the database to reach its limitation and prevent the addition of
records. It is recommended to place photos in a folder, and using a photo field in the template.

1. Select Card Design application > Home tab > Photo.

-Ho;e Card Setup View Laszer
& BT 8 =&

Image

# Signature

a- Fingerprint Figld Mame:

Cut Copy Paste

TextlLabel DataField Compound | Photo [
Field L Image

Imaging

Format type:

Clipboard | Text

Options

| Transparency
[T Chromakiey

[T Invert Image
|| Laser Engrave

Printing

~| Conditional

|| Mardatary Entry

Employee Photo
JPG

|¥! Use a Folder Data Source
I”| This is a Read-only Field

[¥] Maintain Aspect Ratio

~| Non-Printable Entry

|| Print on Fluorescng Panel

rg‘ZJ Select a folder which will contain
=4 the images for these photos

Folder Data Source
Browse... |

Path: Ci\Usersiheriksen'Desktop \Employes Ph
Key Field: |

Record ID {default) |

Placement
Leflt| 570 Width: 96.0 o
Top:| 659 Height: | 120.0 3
Rotation angle {COW): e -
Border and Fil
Border Color: | I Black -
Border Width: et
Rounded Corners
\Width: 040 2 Height: 00
OK | | Cancel
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2. Click in the Card Display pane to open Photo Properties, set the following:

Field Setting

Image Define the field name and select the format type of the graphic.
Field Name: Enter Employee Photo

Format Type: .JPG

Select the Use a Folder Data Source option.

Folder Data | When the Use a Folder Data Source option is selected (in the step above), the Data Source pane
Source in the top right, changes to the Folder Data Source.

Path: Select the path to where the photos are stored.
Key Field: Leave as Record ID (default).
Note: Key fields are covered in Section 4 Data Entry application.

Options Select the Maintain Aspect Ratio option.
Placement Leave whatever data is populated. The text box can be moved using drag/drop.
Printing Do not select any options.

Border and Select the following options as needed. In this example the following was set:
Fill Border Color: Black

Border Width: 2

Rounded Corners: O

3. Click OK.

4. Position and size the photo field on the card.

™ B4 e Card Design - Tempiate_1 - Asure ID - B

E —m,p.i CardSstp  View .
ABRD T 8 & &/mm = \NGD i W weavn=w

-~
o =

@ Fingerprint
Copy Paste || Textlabel DataField Compound || Photo Ea._xgcu_nd lne Polyine Elpee Rectangle | Barcode | |Canter: = 3= Select Al: 13
Field
Clipbasrd Text Imaging Shapes Barcode Editing
S PR o DT .. WS,
— e | ' —\
N /-
HID Global| #
X P
2 % e
/

Data Entry En-gl:u pnm

< ‘ /
Reports - <<Full Name>> \

= iCLASS SE Encoder |

<<Employee Number>>
<<Employee Dept.>>

m s L J  bard Front

_-(-::.1‘ 115.2) Pocels - ' [EES | em -vqé

5. Select File tab > Save Template.
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3.2.7 Add a signature

Adding a signature can either be done through a graphic stored in a folder or through a signature capture

device.

1. Select Card Design application > Home tab > Signature.

BB T &

Card Design application PLT-01485, Rev. 2.5

Card Setup Wiew Laser Signature Properties
" "i # Signature i
) T a' Fingerprnt Field Mame: Employee Signature
Cut Copy Paste | TextlLabel DataField Compound | Photo .--'
Field ‘= Image Format type: JPG
Texi Imaging

Clipboard

~| Use a Folder Data Source
~| This is a Read-only Fisld
Options
|| Maintain Aspect Rafio
Transparency
_| Chromakey
[T Invert Image
|| Laser Engrave
Printing
Non-Printable Entry
~| Conditional
|| Print on Fluorescng Panel

|| Mandatory Entry

Data Source
Source: | Data Entry | . |
Table:
Field:
Placement
Left: 5 Width: 1440 |
Top:| 105.2 Height: 48.0 |
Rotation angle [COW): o° -
Border and Fil
Border Color: Transparent -
Border Width: e
Rounded Corners
\Width: 0.8 2 Height: (-3 S
oK | Cancel

2. Click in the Card Display pane to open Signature Properties, set the following:

Field

Setting

Image

Define the field name and select the format type of the graphic. Do not select the options.

Field Name: Enter Employee Signature
Format Type: .JPG

Folder Data

The Table and Field options are disabled. A signature tablet is used to add the employee

Source signature.
Options Select the Maintain Aspect Ratio option.
Placement Leave whatever data is populated. The text box can be moved using drag/drop.
Printing Do not select any options.
Border and Select the following options as needed. In this example the following was set:
Fill Border Color: Transparent
Border Width: O
3. Click OK.
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4. Position and size the signature field on the card.

R = Card Design - Template_1 - Asure ID = B %
Home Card Setup iew Laser & 'é‘
" = ¢ 2 — — e TS —.
dBRD T & o &4 = \NO W M srrsvuza
- — ] = .} Fingerprint 3 = —

Cut Copy Paste Textlabel DataField Compound & Photo - Background Lne Polyine Elipse Rectangle | Barcode | |center: & fe||select all: 13 |
Field ~ Image - -

el e it Sepes ot Ediwng :

L L e L R e

] 2

[ — g
S . 3

@ :

Card Desian H I D G I O ba I

Data Entry ] Emiplayge Phots
- :'a .
Reports o << >
| ‘}-_ iCLASS SE Encoder | 3 Emy Hnature
| -J Advanced |

<<Employee Number>>

<<Employee Dept.>>

m (I ) cardFront

[(-21.4, 25.0) Pixels ~ | ; l': == &, 169% - Qlﬁ

5. Select File tab > Save Template.
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3.2.8 Add image (logo)
The image (such as a logo) displays on every card.

1. Select Card Design application > Home tab > Image.

Home Card Setup View Laser Tmage Properties .
L i [

@ Fingerprint
Cut Copy Paste | Textlabel DataFeld Compound

Field & Insge Edit Image
Clipboard Text Imaging

QOptions Placement

[¥] Maintain Aspect Ratio teft| &7 Width: | 79.4 *
Transparency

I Chramakey Top: = Height: L2 K

[T Invert Image Ratation angle [CCW): oe -

|| Laser Engrave

Printing Border and Fill

Border Calor: [ Transparent -

Conditional Border Width: - ok
[”| Print on Flucresdng Panel Rounded Corners

Width: 0o : Height:| 0.0 =

i oK I | Cancel

2. Click in the Card Display pane to open Compound Field Properties, set the following:

Field Setting

Image Click Load new Image from file. Browse to locate the file.
The graphic appears in the Preview pane.
Note: If this is not the correct graphic or needs editing, select Edit Image.

Options Select the Maintain Aspect Ratio option.
Placement Leave whatever data is populated. The text box can be moved using drag/drop.
Printing Do not select any options.

Border and Select the following options as needed. In this example the following was set:
Fill Border Color: Transparent
Border Width: O

Rounded Both options (Width and Height) should be left at O.
Corners

3. Click OK.
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4. Position and size the image field on the card.

(L] _E & @ Card Design - Template_1 - Asure ID - 8 x
E Homie Card Setup View Laser S \Q‘:’J
1 2 Fﬂ = = /£ Sgavre gy \ Q H [t B ST I = o
B T8 &Ry = N R T
Cut Copy Paste Textlabel DataFeld Compound | Photo - Background Line Polyine Hlipse Rectangle || Barcode | |center: & fe | [select All: 3 |
Fild % Image = i
':hpngard Text Imaging Shapes Barcode El:_Ilhpq :
L L P
1 &
| e iome 1 g
@ [ | %’
- ] &
Card pesn - HID Global
Data Entry | Emplayge Phots
Reports - <<Full Name>=>
|_J}:' iﬂ:t._s_ﬁ_%'_ﬁ.tcod_z i | 1 Empl; nature
| ) Advanced | i
T 1] <<Employee Number>>
] <<Employee Dept.>>
(200

(105,85, -5,1) Pixels - | l,;-_; I &, 164% le

5. Select File tab > Save Template.

3.2.9 Background

A background displays on every card. This can be customized as a solid color, sample background or you can
add your own background to the folder Asure ID > Images > Asure ID Backgrounds.

1. Select Card Design application > Home tab > Background.

Note: If the card is dual-sided, you can select which side to apply the background. You can also
right-click on the card and select Add Background.
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2. Select Add Background to Front of Card.

Home Card Setup Wiew Laser Background Properties
SR T 8 w i
5 —= . @ Fingerprint Field Name: |Color [AliczBlug]
Cut Copy Paste | Textlabel DataFeld Compound | Photo =
Field = Image Select an Image:
Clipboard Text Imaging
Add Background to Front of Card
#
Add Background to Back of Card |
- f« [
Select a Color: | 1 Alice,., = Preview Only

Loadanlmage:l Brewse... |

Edit Image: |
Printing
Display Conditionally

7| Do nat display

i O ! | Cancel |

3. Set the following on the Background Properties window:

Field Setting

Image Click Load new Image from file.
The graphic appears in the Preview pane.
Note: If this is not the correct graphic, or needs editing, select Edit Image.

Options Select the Maintain Aspect Ratio option.
Placement Leave whatever data is populated. The text box can be moved using drag/drop.
Printing Do not select any options.
Border and Select the following options as needed. In this example the following was set:
Fill Border Color: Transparent
Border Width: O
Rounded Both options (Width and Height) should be left at O.
Corners

4. |In this example we select a color background. From the Select a Color option, click the Web tab. Select
a color from the pull-down list. The color selection appears in the display window.

5. Click OK.
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6. The background now displays on the card.

> B< e Card Design - Template_1 - Asure [D - B x
ﬁ Home Card Setup View Laser 2 @
g =N p=. : Signatur -y v\, Polyline : Wh S
RO T 8 & R4 = |\ 0o | g EaFazd
g = © Fngerprint @ Elos= Center: 1 8
Cut Copy Paste Testiabel DataFeld Compound Photo Background tine Barcode e
Fisdd ~ Image - il Rectangle Select Al (2
Clipboard Text Imaging Shapes Barcode Editing
s P = " = . e
| i vome 1, -~
card Desain ] Employxs Pron
o 'ﬁ <<Full Name>> |
Data Entry Emp flire
¢ = <<Employes Number>>
______________
] ttEmplﬂynﬁ Dapl >> $
........... =
Regerts : Card Front
= ICLASS SE Encoder B :
- — — — - -
€ Advanced __l F L = i e P e I e e L
H ¢ ~
=
- Card Back
E \
(302.1, ~13.1) Pixels = [EES R m%-

The basic card template is completed.

At this point you can edit any fields by double-clicking on the object and changing the properties in the
dialog box.

Fields can also be freely moved by drag-and-drop or by changing the Placement properties window
(displayed after double-clicking the object).

Resizing of an object can also be done by selecting and dragging by the handle to resize.

7. Select File tab > Save Template.

3.3 Advanced card design tutorial
Building upon the basic card template, you can add options such as:

m  Shapes - See the Card Design section in the Asure ID Reference Guide, Section 3 Card Design
Application (PLT-01797), for information on adding shapes.

m Barcode - See Section 3.3.1 Add a barcode
m  Magnetic Stripe - See Section 3.3.2 Magnetic stripe (magstripe)
m Smart Chip - See Section 3.3.3 Enable smart chips

Note: For information on the PACS Registration, Laser Writer, or Live Link, see the Asure ID Reference
Guide, Section 3 Card Design Application (PLT-01797).
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3.3.1 Add a barcode
Select Card Design application > Home tab > Image.
_ - .H;J-I'I;E Card Setup Wiew Laser ES @‘!.b

Signatu | 2 O
T & o 347 = \NG@ i [W)srmarn=a
- b y & Fingerprint e
Cut Copy Paste  Textlsbel DataFeld Compound = Photo Background Line Polyline Elipse Rectangle | Barcode

Field £ Image
Clipbosrd | Texi Imaging Shapes Barcode Editing

|Center: S B | |select all: 1T |

3.3.1.1 Barcode data tab
1. Click in the Card Display pane to open Barcode Properties set the following on the Data tab.

Barcode Properties
pats IEEEEE :
Barcode Quiet Zone
Field Name: Barcode [¥] Include Quiet Zones
Type: Code 3% - Width: il
Test String: | 1234567390
Placement
Font: | Arial a
< — Left: 99.8 % Width: | 95.0 5
FontSize: (12 2 ]
Maintain Aspect Rati = 2 S
Ratate (GO | por || A SPECLRatg Top: 175.0 * Height: | 240 *
Create Fields Bar and Fill Calor
Create a new Data Field Bar Color: | I Black -
Create a new Text Label Fill Calor: | 1 Transparent -
Printing
Select Fields | Mon-Printable Entry

Available: Active:

Employee Nur £5
Employee Dep e e
Full Name - | <= Remove |

| Laser Engrave

QK | | Cancel
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Field

Setting

Barcode

Field Name: Enter Barcode.

Type: Leave the default Code 39. There are many options available from the drop-down
list. See the Asure ID Reference Guide, Section 3 Card Design Application
(PLT-01797), for information.

Test String: Leave the test string.

Font: Arial

Font Size: 12

Rotate (CCW): O

Maintain Aspect Ratio: Select this option.

Create Fields

Select Create a new Data Field. See Section 3.3.1.2 Create a barcode data field.

Select Fields Select the Barcode Data field from the Available —
pane, and click Add to move to the Active pane. e
Note: This can only be done after the Barcode koot _ Rt
Data field has been created in the field Emplayee Nur B Add > |
b Employee Dep =]
above. Full Name - | <= Remove |
Quiet Zone Select the Include Quiet Zones option. This leaves a white area around the barcode for
ease of reading.
Placement Leave whatever data is populated. The text box can be moved using drag/drop.

Bar and Fill Color

Select the following options as needed. In this example the following was set:
Bar Color: Black
Fill Color: Transparent

Printing

Do not select any options.

2. Click OK.
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3.3.1.2 Create a barcode data field
1. Select Create a New Data Field. This is the information coded into the barcode.

2. The Data Field Properties window opens.

Data Field Properties
Data Field
Field Name: Barcode Data Field Type:
Advanced Data Field Options -
) Tet
Field Options ~ List
| This is a Unique Field _) Date
|| This is a Read-only Field ) YesfNo

“| This is a Mandatory Field

Faont Alignment
Font Mame:  Arial ki Harizontal: |E|“:| “E|
Font Color; | M Elack i Vertical: ||:| IID =] |
Font Height: |12 o m
—_—— Rotation: 1 30
Fontstyle: | B|.7 fu s | ({tn degrees )
Options Placement
Il Word Wrap left:| 0.0 3 Width:| 9603
I Reduce To Fit

[l e B Top: 0.0 - Height: 240

Printing Border and Fill
[ Mon-Printable Entry Border Color: | ] Transparent -
Border Width: 03

[ Print on Fluorescng Panel o] || pansparent e

! OK | ! Cancel i

3. Set the following on the Data Field Properties window.

Field Setting

Data Field Define the field name and enter the text to display in this field.

Note: The Field Name should be a name that can be associated to the actual field text.
Field Name: Enter Barcode Data
Field Type: Numeric
Field Options: Do not select any options.

Font Set the font options. In this example the following was set:
Font Name: Arial

Color: Black

Font Height: 12

Font Style: No selection was made.

Alignment Select alignment options. In this example Both options were set as Center.
Options Do not select any options.

Placement Leave whatever data is populated. The text box can be moved using drag/drop.
Printing Select the Non-Printable Entry option.

Border and Select the following options as needed. In this example the following was set:
Fill Border Color: Transparent

Border Width: O

Fill Color: Transparent
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4. Click OK. You are returned to the Barcode Properties window, and this newly created field is listed on
the Select Fields > Available pane.

3.3.1.3 Barcode options tab
1. Select the Show Barcode Text. option.

2. Click OK.

‘Barcode Properties
ﬁ Barcode Options

Linear Barcode

Check Character Bearer Bars

[5] Include Check Character [T show Bearer Bars
Default Width:

Mod10

|- Ok | | Cancel

3. Position the barcode field on the card design area.

e |BS @ Card Design - Template_1 - Asure ID - B x
ﬁ Home Card Setup View Laser )
‘__l | re— I A = (el —— T i. T
= [ 1 E:I; Ruler Units: Picels = | Lﬁl |._=_i q e q L, =
i |77 ~
5nap To |Sngp Sixe: 10.0 - | Previews | Fit Card Zoom In Zoom Out | Gridines Rulers.  Card Smart
Grid Mode || In View Properties Chip
Workspace Zoom Show Hde
1 T S [ I /I s i P i

- e i

HID Global

<<First Name>> <<Last Name>>

Employsé Phoio

s HID Global
(N <<Employee Dept.>>

\ J

m Gard Front

(143.0, 157.1) Pixels = | u R, 177% ia

L

4. Select File tab > Save Template.
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3.3.2 Magnetic stripe (magstripe)
The Magstripe option is located on the Card Setup tab.

The magstripe is located on the back side of this card template. The default position is the top of the card.

e B E e Card Design - Template_1 - Asure T - 8%
Home Card Setup . Wiew Laser £ '{}'
aen B E Sl e ¢ |

= T & & =
CR-80 ] custom Dual-Sided Mirror | Landscape Portrait | Magstripe Enable PACS Laser || DataSources Data Views
Card Card smart Chips ~ Registration Writer v -
Layaut ';r:en'auc_-rl Tedmolog ¥ Live Link
To Add a Magstripe:
1. Select the Card Design application > Card Setup tab > Magstripe.
Magstripe Properties ' Magstripe Properties '
Lressvre JRERNEEAREE R o2 TN
Type Create Fislds
5 =0 Create a new Data Field
Mon-150 Create 3 new Text Label
Custom
Select Fields
Ciptions
Aysilzble: Active:
| Fill unused space with zeroes

Employes Dep |
Full Name |

3 Barcode Data =3 | == Remowe |
|| Remowe Magstripe R B TEE

|¥] Place Magstripe at card bottom

oK l | Cancel |

| oK | | Cancel |

2. On the Magstripe tab set the following:

Field Setting
Type Select the ISO option.
Options Select the Place Magstripe at card bottom.
3. On the Track 2 tab click Create a new Data Field.
Field Setting
Create Fields Click Create a new Data Field. See Section 3.3.2.71 Create a magstripe data field.
Select Fields Select the Magstripe Data field from the Available R
pane, and click Add to move to the Active pane. i
Available: Active:
Note: This can only be done after the Magstripe Data
field has been created in the field above. EEFLT:EZ Der il | |
Barcode Data = !_M|
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3.3.2.1 Create a magstripe data field
1. Set the following on the Data Field Properties window.

Data Field Properties N i i _)gl
Data Field
Field Mame: Magstripe Data Field Type:
Advanced Data Field Options & Text

Field Options List

Field

() Numeric

[] This is & Mandatory Field
Font Alignment
FontMame: Arial % Horizontal: |E| |||:| |||:| |
Font Color: | I Black s Vertical: i-El_"E-ilii
Font Height: |12 = Rotsti — D_‘
e otation: %
FontStyle: | 8| 7 [u s | (In degrees cCw)
Options Placement
[T} word Wrap Left:| 0.00 5 width; | 100 3
[C] Reduce To Fit

[l briser Encras Top:| 0.00 .| Height: 0257

Printing Border and Fill
[¥] Non-Printable Entry Border Color: | [ Transparent -
Border Width: B

[E1 Print ori Fluorescing Panel Fill Color: | ] Transparent -

| Ok | I Cancel

Field Setting

Data Field Field Name: Enter Magstripe Data
Field Type: Text
Field Options: This is a Unique Field

Font Set the font options. In this example the following was set:
Font Name: Arial

Color: Black

Font Height: 10

Font Style: No selection was made.

Alignment Do not select any options.

Options Do not select any options.

Placement Leave whatever data is populated. The text box can be moved using drag/drop.
Printing Select the Non-Printable Entry option.

Border and Select the following options as needed. In this example the following was set:
Fill Border Color: Transparent

Border Width: O

Fill Color: Transparent

2. Click OK. The magstripe is added to the bottom of the back of the card.

September 2018 47



Card Design application PLT-01485, Rev. 2.5

3.3.3 Enable smart chips
Cards listed under the Enable Smart Chips option, have a smart chip embedded in the card.

Note: The Smart Chip is not visible on the card template.

For enabling other types of smart chips other than what is shown in this example, see the Asure ID Reference
Guide, Section 3 Card Design Application (PLT-01797).

The Card Properties pane shows any applications added. This section is only covering using iDIRECTOR® to
enable an iICLASS® smart chip for a read application.

To Enable a Smart Chip:
1. Select the Card Design application > Card Setup tab > Enable Smart Chips > IDirector > iCLASS.

T ’
Home Card Setup View Laser ® Q
| o
= crre (= |1| = [D -J:jJ ¥
= =] =] W= ® v g
CR-80 [3] Cystom DualSided Miror || Landscape Portrait | Magstripe Enable PACS Laser Data Sources  Data Views
Card Card ige W egistration  Vriter - hd
S it iDirector (HID OMNIKEY 521/5¢25)  » I Prox (OK5125) |

O

| frone _ﬂ
(el ) r

L iDirector (HID OMMNIKEY 5127 CK Mini)
iCLASS SE {CP1000 OMNIKEY 5x27)

Command Line

_icassosion Jo—o b v 1y

MiFare (OK5121)

I &

2. The iCLASS Chip Properties dialog box opens.

@ ICLASS Chip Properties ..
Configuration
Card Type:
2K1 - | Auto Detect
Actions
|E| Add an Application
Properties
| oK || - Canecel
Field Setting
Configuration Card Type: Select the card type from the pull-down list.
Note: If the reader is connected, select Auto Detect. For this example, leave the default
(2KD.
Actions Click Add an Application.
Properties No settings for this option.

48

September 2018




PLT-01485, Rev. 2.5

Card Design application

3.3.3.1 IDIRECTOR wizard
The iDIRECTOR® wizard allows you to add an iCLASS® application.

1. On the welcome window click Next.

Add iCLASS Application ==

Asure ID

Welcome to the wizard for
adding iDIRECTOR applications

This wizard will guide you through the process of adding an application
o a card technology,

Widgieb e To continue, dlick Next

| Cancel |

2. Select the HID Access Control Application (Read) application.
3. Click Next.

Add ICLASS Application [Esem]
Application Selection

Flease select the application you would like to add. Double-dick to jump directly to the
next page.

[ Applications
Py
(=] ;I L‘: N
| IHID Access Control Application (Read) l
£ Read C3N (Read)
B RFIDeas AIR. 1D (Write)

ﬁ! Custom Application {Read/Write)

| < Back || Mext = |

| Cancel

4. Select the H10301 (Std 26 Bit) Format Type.

Note: This configuration cannot be changed after the wizard is completed. If the application needs to
be modified, you must delete the existing application, then add a new one.
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5. Click Next.

Add ICLASS Application

Application Configuration
Thiz configuration cannot be changed after the wizard is completed.

o ST (H10301 {Std 26 Bit) Auto Detect, ..

H10302 (HID 37 BIT)
H10304 (HID 37 bit FAC+CN)

Ha0245 . If the format you are trying to read is nat

HS0XXX {Corp 1000 Generic) | jisted here, please contact your HID reseller

T12301 {THORM) for assistance in purchasing a custom format
file,

|§ = Back ;|| Next > Ii €ancel |

6. Select the Create a Data Field for each IDIRECTOR Field option for this example.
Create a Data Field for each iDIRECTOR Field option:

= Disabled: To read HID Access Control Application information and write it to an external data
source.

=  Enabled: Asure ID creates a data field for the Facility Code and Card ID Number to be stored
within the Asure ID native database.

7. Click Finish.

Add iCLASS Application

Asure D Application Added

e — h ‘You have successfully added an application to the card technology.

l‘_r Create a Data Field for each IDIRECTOR Field l

PP S e To complete this operation, dlick Finish

< Back Cancel
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8. A new tab with the new application is added.

@ CLASS Chip Properties l
Enel HID Access Control Application [% m@

Configuration

Format Type: =

| Fields
| = Fadiity Code (Read)
¢ lep| <<Fadity_Code>>
c@ Card Id Mumber (Read)
.| < <Card_Id_Number=>

Key Management

s

Properties

Mo properties defined for this application

K | | Cancel
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9. The advanced card template is completed.

w B P Card Design - Template_1 - Asure 1D - =82 X
- Home Card Setup View Laser 2 @
' - ] =5 = - - '
EHeer HHHEE S = Pe ¢ s |
CR-80 5F custom Dual-Sided Mirror  Landscape: Portrait || Magstripe: Enable PACS Laser Data Sources  Data Views
Card Card Smart Chips ~  Registration Writer - -
i i Aeniaten Feriwiony idei 2
_||"||MW|W. B
| ﬁ-?—bme |n_ ~ - Smart Chip Applications )
- icLass
@ m“ HID Global L:J@ HID Access Control Application
Card Design VA Il m Fadility Code (Read)

p— i T L] < <Fadlity_Code>>

| Il <<First Name>> <<Last Name>> B Card 1d Number (Read)

4_| o e

Data Entry ] M‘ L f=| <<Card_Id_Number>>
1 L|E\ add application
= X ]
=) ! HID Global
<<Employese Depi.>>
g 100 200 300
I A e T L A T T 0 1 A O ] 1 v B 0
- -

N

. T P

Card Back

|(73.0, 237.1) Pixels v |

omecron

NﬁEI = & w0% - QW
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4 Data Entry application

Section

4.1 Data Entry overview

The Data Entry application allows you to populate the database created in Card Design with the appropriate
data for the card, and print the designated cards.

Note: The Asure ID® Solo edition is limited to 200 records.

The Data Entry application has the following tabs, with a corresponding toolbar.

= File: The File tab allows you quick access to open a template or data group, printing, encoding and

Laser writer access.

= Home: The Home tab allows the configuration of data input, photo and signature acquisition, and

record finding/filtering options.

m Database: This tab groups import/export and record archive, restore, refresh options.

= View: This tab groups the views of current records and record layout options.

m  Advanced: This tab groups laser controls, encoding, and PACS Integration.

Card Design

7]
Diata Enfry

Reports

| ) icLASS SE Encoder |

| €9 Bdvanced |

4 Record 0 of Ok

o B e Data Entry - Template_1 - Asure ID
E Haomie Database Vi Advanced
L_| = [ = n=| “= s f ==
== =i A e = % Global Find 4
= T N R A - R @ /
Standalone  Quick Add Delete Capture  Load From Find A peplace Quiick
Encode Print ’ File = ki Filter
Card Issuance Recc_-rds Acquire Find

0 Records in Database

& | &) Select Al
& Deselect Al

&' Select Record a

Select
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4.2 Data Entry Home tab

The Data Entry Home tab contains the basic tools to create a data field. See the Asure ID Reference Guide,
Section 4 Data Entry Application (PLT-01797) for detailed information on these tools.

s He : Data Entry - Template_1 - Asure ID - mx
Home Database View Advanced x @
= i N W r—N 1 = ; % Clear Filter A Select Record

W OEEE 0T @ e Rawm v
= — - ; Show Filter « DeSelect Record
Standalone Quick | S Add Delete Void Capture loadFrom | Fnd A& pagjare  Quick Select DeSelect
Encode  Print . File = w19 Filter Customize Filtter ~ Al Select Range
Card Issuance Records Acquire Find Select

4.2.1 Add a record with data, photo, and image fields

Records can be added individually or in a batch. To add more than one record at a time, select Add Batch and
input the number of records to add. The window displays these as blank records.

Note: This option cannot be used if:
= The data field is linked with Live Link.
= There are mandatory entries on the template.
Add a Single Record:
1. Select the Data Entry application > Home tab > Add.

Dats Entry - Template_1 - Asure ID - = x
Viess Advanced " ]
2 0G0 @ e Ay T Q@
=+ | D o X Show Fiter & DeSedect Record
Delfetz  Void Caphoe  Load From Frd A penlace Quick Select DeSelect
- Fie » e Filker Customize Filter All Al &) SelectRange
Aecords Acquere Find Select
Template Record 1of 1 2
| i Home
Setect:
@:I * Employes Numbar: HID Giobal -
g {j Print Count: ]
SR } riot Date: O w0 Global ,
'[ £} PontBy:
e L] Voided: No g
[iata Entry E
&4 Void Date: e
£Y . e
° L4 Voud By:
A L} Record ID: 3
Employes Dept.: <NULL >
| ) icLass SE Encoder | First Name:
| € A " | Last Name:
Empioyee Photo: No image data
Employes Signature:  No image data
Barcode Data; 2
Magstrips Data: <NULL>
|3 Facity_Code: a
4§ Card_Id_Number: a
i - C— i o e B
2 Records in Database b ‘.9'] —-]ﬁ_h
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2. A new, empty record is displayed.

Note: The data fields that were added when designing the card template are listed on this new record,
ready for the entering information.

3. Enter the following information:

Field Information
Employee Number Enter JDoe 12.
Note: The red star indicates the field is required.
Employee Dept. Select Engineering from the pull-down list.
First Name Enter Jane.
Last Name Enter Doe.

4. To add an Employee Photo:
a. Right-click on the Employee Photo area and select Load from File.
Note: Alternatively you can select the Load from File option from the toolbar.
b. Browse and select the employee image file.
c. Crop the photo as needed in the Edit Image window, and click OK.

Note: To re-open the Edit Image window, double-click on the image.

Edit Image @
E|

Set Crop Size As Default
. Effects =5 | | -cancet
¥ Use Aspect Ratio | Show Crop Box >
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d. The Effects option opens a window that allows you to modify the image for best results.

Image Effects
Image Effects
Brightness 1
Bl
Contrast o
Hue (=)
L.
Saturation =
S
Sharpness H
T . .
|Restore Defaults | | QK | | Cancel

5. To add an Employee Signature:
a. Right-click in the Employee_Signature area and select Capture Signature.
b. You need to use the signature pad for capturing the signature.

c. Click OK.

Capture Signature

e

| Resst | I oK Il Cancel |

Employee Signature:

6. Click Barcode Data and type 123456 into the text field.
7. Click Magstripe Data and type 12345678 into the text field.
Note: For Track 2 data requirements, see the Asure ID Reference Guide (PLT-01797).
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8. Click Save within the Records group. When the Save button is selected, the card previews in the
Preview and Filter Manager pane.

S = ™ Data Entry - Template_1 - Asure ID ST
ﬁ Home Catabase View Advanced = 9
(=] - “re a-| (=& 4 + i Clear Filter [~ v Select Record
== 2 1E @ = @ ammy v @
—= Show Fiter & Des Record
Standalone  Quick Delete  Void Capture  Load From Fird A penlace Cuick Selact DeSelect :
Encade Print - File = = Filler Customize Filber All Al & Seect Range
Card Issuancs Aecords Acruire Find Sedact
Template Record Lof 1 =
o Home |
2 Select;
\
@ v Employes Number: HID Global - 1Doe 12
Card Design §4 Print Count: ] m HID Glcbad
- i§ Print Date: b
_F U4 PrintBy: John Dae =a
s PR 14 veided: o L]
p— 44 Void Date: i ety
- i voidBy:
Reports §4 Record ID: 1
Employes Dept.: Engnesring
© irLass SE Encoder it e
| ) Advanced | Last Name: Doe
Employee Photo; A
st A
Empioyee Signature
Barcode Data 123455
iMagsirips Data: DOE J 12345
§ Faciity Code: ]
4 Card_Id Number: o
m ¢ 4 Recordlof1 + 4 b — Preview
1 Records n Database L =M gli=

9. To see an enlarged version you can double-click on the preview.

s Cord Prviess (52%) =l

2,0 Q @ & O

Wew Pront. Vew Back Zoomin Zoom To Fit Joom Cut  Print

1) HiD Giobal

Jane Doe

HID Global - JDoe 12

[ L Engineering
123456

When this card is viewed in the enlarged preview, it is noticeable that the alignment of fields is visually not
the best. This is where using the edit tools in the card design comes in handy.

Editing can be done at this stage by returning to the Card Design application and moving fields into better
positions.

Note: The Facility_Code and Card_ID_Number cannot be edited.
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4.3 Data Entry Database tab

The following section covers the Data Entry application Database tab. For additional information on the
database and records see the Asure ID Reference Guide, Section 5 Databases (PLT-01797).

i H Diata Entry - Template_1 - Asure ID = =X

ﬁ Home Databasze View Advarced 2 @

= Py ke {E‘". 'fﬁ. Ry
& & & U |y

Import  Export Refresh Archive Restore Export
Wizard Wizard - h Selected

Import f Export Recards

4.3.1 Import/export

Record information can be Imported from a MS Access database, SQL Server database, Oracle database,
Excel, or a comma-separated values (CSV) file.

Import record information from a CSV file

1. Select Data Entry application > Database tab > Import Wizard.

w  H e Data Entry - Template_1 - Asure ID - =7 X
| Home Database View Advanced 2 g
I 3 . é {g‘l ‘ﬁl _" s
L= R - I R =
Export Refresh  Archive Restore Export
v Selected
Import / Expaort Re_u;qrd_s

2. The Import/Restore Wizard opens. Click Next.

Tmport Wizard

. Welcome to the Data
Asure |D & Import/Restore Wizard

— -—a-w"

This wizard will help you import data into Asure ID or restore it from
an archive,

hidglobal.cem

To continue, dick MNext

3. On the Choose Import Source window, select Comma Separated Values.
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4. Click Next.
}npoﬂWm!ﬂ
Choose Import Source W
Choose the type of data source that vou will impart from. e

Select an Impart Source Type:

[Comma Separated Values
SQL Database

Orade Datsbase

ODBC Connection

Excel Spreadshest

[ Log all recards

i < Back I| Mext = || Cancel |

5. On the CSV Import Source window set the following:

Click Browse to locate and select the database to be imported.
Select the Contains Header Row option, if this applies.
m  Specify the Delimiter in the file.

6. Click Next.
| import Wizard
C5V lmport Source W
Select the file to import from. ' 4
-\
Enter the complete path to the Text Fil
or dick browse to select a file,
C:YUsershadmin'Desktop \Records \Employee Records.csv
| Contains Header Fow | Browss
Delimiter:
I <Badk I Mext = Cancel
s  Ee———3 "
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Below is an example of the CSV file.

IE' =, R vl Employse Records.csv - Microsoft Excel = = =R
- Home Insert Page Layout Formulas Data Review View Acrobat w2 0 = EE 8
A2 = £ y
A ! 8 C D E F G H =)
Employee Employee First Employee Employee Barcode
1 |Number Dept. Name Last Name Photo Signature Data Magstripe Data
3 1 400 Jane Doe 123456 DOE 112345
3 13 400 Mark  Miller 123481 MILLER M 12346
4 14 401 Mike Evans 123506 EVANS M 12347 a
5 15 200 Mary Smith 123531 SMITH M 12348
5] 16 400 Helen Fisher 123556 FISHER H 12343
7 i7 400 Allen Ross 123581 ROSS A 12350
3 18 400 Bob  Birdsall 123606 BIRDSALLB 12351 y
) 19 400 Rob  Kolowski 123631 KOLOWSKI R 12352
1o 20 510 Peter Paul 123656 PAUL P 12353
11 21 400 Rory  Hill 123681 HILLR 12354
12 22 400 Peter Gill 123706 GILLP 12355
13 23 200 Dave Johnson 123731 JOHNSON D 12356
14 24 400 Archie Jones 123756 JOMES A 12357 -
W 4+ M| Employee Records . [14] i |
Ready | [ | || 100% (=) !

7. On the Field Links window, to map the data fields:

a. Select a Import Source Field, and then the corresponding Template Field to link.

b. Click Add.

impert Wizard

Field Links

Employeehumber -> Employes_Number {Unigue)

Employee Dept# -> Employes_Dept_

iFirst Name -= First_MName

LastMame ->Last Mame

Employee Signature -> Employee_Signature

Set up the links between the import sources and the template,

-
Import Source Fields Template Fields
EmployesMumber Voided -
Employes Depts Woid_Date
First Mame ‘oid_By
Last Mams Record_ID
Employee Photo Employee_Dept_
Frst pime
Barcods Data Last_Mams
Magstripe Data Employee_Signature

Barcode_Data -
Field Links

Barcode Data -» Barcode_Data |
! Remove Il Mark Unique |IL; Image File Import z|
[ <Badc || tee> o | cancel

8. Select a Field from the Field Links and click Mark Unique. A unique field separates each record so there

are no duplicates.
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9. To import a image:

Select a Image Field.
Click Image File Import.
Click Browse to locate and select the image file to be imported.

Select the Column Containing File Reference option, if this applies.

®© o 0 T ®

Specify the image File Type.

Note: Importing an image file in this manner removes any preexisting photo links into the wizard. When
importing a CSV source, photos need to be retrieved from an external folder.

File Import

Folder to Import from:
C:\Users\adminDesktop\Employee Photos

|
Column Containing File Reference: Browse |

Employee Photo

[T| Column contains actual file names
Image Type:
IPEG (IFG) = |

aK | Cancel |

10.Click Next on the Wizard Field Links page.

11. On the Import Options window, select the Update existing records and import new records option.

Import Wizard
-
Import Operation
l 2 Update existing records and import new records l
~ Impaort new records only
Update existing records only
| <Back i Mext> i | Cancel |

12. Click Next.
13. Click Begin Import to update existing records.

Note: As the update is performed, the log is displayed in the window.
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14. Click Next when complete.

Import Wizard

Import Data
Click the Begin Import button to start the import/restore process,

Reading Data
Refrieved 24 rows of data,

A column named ‘Employes_Signature’ already belangs to this DataTable.

Begin Import

Cancel

i

15. The import is complete. Click Finish.

Note: The Data Entry records are added/updated with these changes.

Import Wizard

Completing the wizard

You have successfully complated the wizard

hidglobal.cem

To doze this wizard, dick Finish

Cancel

PLT-01485, Rev. 2.5
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4.4 Data Entry View tab

The Data Entry View tab, contains all the tools to customize the views, including customizing the record
layout. For detailed information on the View tab, see the Asure ID Reference Guide, Section 4 Data Entry
Application (PLT-01797)

Records can be viewed as a single/multiple view or in a table format.

Dirag & cohenn hesder hers o group by that column
| i Home |

First bame Last Name Employes ... | Employee ...

Barcode Diats | Magsinpe ..

i H e Data Entry - Template_1 - Asure ID =
ﬁ Hame Databiase Advanced z @
— . m T —
" s 2.0 = Sgls R w e Font Type: Tahoms
[ Single Column [ Sngle Row e
T t T P &) t .
Record. Table B Mitiplec 2* sl Rios 'an  Customiz® [ pesstlavout FontSre: 8
Ciate Mods vigw Record Views Layput Fant
Template Record 15 of 23 2
| i Home:
@ ¢ Employee Number: HID - Doe 12
o &4 Prnt Count: 9 I o Giobat
|.;_ i} PrntDate: g
[ L) PrintBy: 1ahs Doe
= P
c " i veided: No -]
L} ‘Void Date: i Brcpruorng
Y Voud By:
Reports U} Record ID: 1
Employes Dept.: Engnzenng
| icrass S Ercoder Frst Hama: ane
| €3 mavaresa Last Name: Doe
Employes Photo: "..;. --‘
- —
Employes Signature:
Barcode Data: 123455
Magstripe Data: DOE 1 12345
{} Fadity_Code: 2
i Card _1d_Mumber: 2
B
|r- E b Data Entry - Template_1 - Asure ID e
- ﬂ Home Database view Advanced * @
—
= e ﬂ W [°4 CInteadTovew FontType: Tahoma -
z Record] Table Pan Customize [} Resetlayout [FontSae: 8
Data Mode View Rem’n_ Views Layput Font

200 Mark 123481 MILLER M L...
Card Desgn W01 Mike Evane 123505 EVANSM 1., OID wio Global A
|j 200 Mary Smith 123531 SMITHM 12.., e
o 00 Felen Faher 123556 FISHER H 1... TR, o
il 400 allen Ross 123581 ROSS 4 12... i
S W Engmeerny
e 400 Bob Birdsall 123606 BIRDSALL B...
P 00 Rob Kelpwsha 123631 KOLOWSHT ...
HID - PPaul 20 510 Peter Pad 123656 PALL P 12353
| @mssssEEncader | HID - il 21 00 Rery - 123681 HILL R 12354
| € Advanced [ HID - PGA 22 400 Peter al 123706 GILL P 12355
HID - Ddohnson 23 200 Dave Johnson 125731 JOHNSON ...
HID-AJones 24 400 Arihie Janes 123756 JONES 4 12..,
00 Fred Farmer 123781 FARMERF .,

w4 Racord 10F23 0wk [T

_ﬂ Records in D:tabue
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4.5 Data Entry Advanced tab

The Data Entry Advanced tab, contains the advanced options that may be installed on the printer. If the
options are not installed they are grayed out.

Advanced options are:
= | aser Controls
= Encoding

m PACS Integration

For detailed information on these options see the Asure ID Reference Guide, Section 4 Data Entry Application
(PLT-01797).

i H Data Entry - Template_1 - Asure 1D = =X

E Home Database View ® ‘«!-_:F'

P 5 P s

. jﬁ Bgy o T
Reset @:
; Laser :
Lazer Controls Iy Encoding Ty PACS Integration
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5 Reports Application

The Reports Application provides you with preformatted reports of application operation. Reports can also
customize in terms of layout, columns, and filters, which can be saved for future use.

i Reports - Asure ID - g x
ﬂ Home Custom Reparts & g
o, I L & Records withna Phatos |7 1) wIdn | S & —}
tj | 2 User Activity I-[Fj| ¥ | \l?) ; : ;] : [ - @ |_E_t e i .
- W Unprinted Records — e
Userlist D} User Login All Records e Template PrintHistory | Template DataFields | Refresh Export  Save Custom
for & template 148 Voided Records History Report List for Template - Report
User Reports Data Entry Reports Card Design Repor s Bata

5.1 User Reports
m  User List: This report contains all users, capabilities, and general information.
= User Activity: This report contains all the detailed user activities.

m  User Login: This report contains all user login activity.

5.2 Data Entry Reports

Note: Right-click on any column heading in a report, for additional Column options. for more options.
Columns can be rearranged or removed as required.

= All Records for a Template: This report contains all records (and associated data fields) for a selected
template.

= Records with no Photos: This report contains all records (and associated data fields without photos)
for a selected template.

= Unprinted Records: This report contains all records that have not been printed, for a selected template.
= Voided Records: This report contains all voided records for a selected template.
= Template History: This report contains all user activity for all templates.

= Print History Report: This report contains history of all reports printed.
5.3 Card Design Reports

= Template List: This report lists all the current templates.
= Data Fields for Template: This report lists the data fields for a selected template.
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5.4 Create a report
The following is the general process for creating a report.

1. Select Reports application > Home tab > All Records for a Template.

[T Reports - Asure ID - B X

—— '

File Home Custom Reparts & @
3:' P L hewity @ Records with no Phatas ; |_> il ) b = g "'! *I lﬁ |

u'.‘ﬁ Unprinted Records =
User List :I. User Lagin All Records : Template PrintHistory | Template Data Fields | Refresh Export  Save Custom
for & template |48} voided Records Histary Report List  for Template - Report
Uzer Reports Data Entry Reports Card Design Reports Data

2. Select a template to run the report on.

Note: This option is only required when needing Record or data entry field information (i.e. Data Entry
Reports, or Data Fields for Template report.

3. Click OK.
Select Templata xX
Lremplate_t J

Cancel |

4. The report is displayed. This example is the All Records for a template.

3 Reports - Asure 1D TR
ﬁ Home Custom Reports 2 ‘?
= =" Records with no Photos | 7| T (535 f== *‘ ==
& romsae @y P [0 Q[ w0 6 € (S
— & Unprinted Records -
Liser List 3 User Login All Records Template Print History Template Dats Felds  Refresh Ewport  Save Custom
for & temgplate 48 Vouded Records History  Repart List  for Template . Report
Lisesr Reports Data Entry Reports Card Design Reperis Data
All Records for a template - Template_1 o
| o Home Drag's colimn hsader fere to group by that cofumn
O Employes Number Print Count | PrintDate | Print By voided Void Date  VoidBy |RecordID @ Employee Dept First Name Last Na
ey HID-Mvler 13 © j 5 00 Mark Hiller
l HID - MEvans 14 0 6 401 Mike Evans
HID - MSmith 15 L] ¥ 200 Smith
Data Entry oy
- HID - HFisher 16 o ] 400 Haben Fisher
° HID - ARoss 17 [ 3 400 Alen Ross
Rapgets HID -BBirdsal 18~ D 10 %0 Bob Birdsall
HID - RKolowsld 19 @ 1 00 Reb cHlorsh
|
©nusssetnnder || ppay 0 0 12 510 Peter Paud
£ Advanced || #D-reaa 0 13 400 Rary i
HID - PG 22 g 14 400 Peter Gl
HID -Dlohrson 23 © 15 200 Dave
n*ﬂ]’l - Alones 24 i Archis oo=s
il ¥
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5.5 Custom report

A custom report is any report that you have run, that you have changed the layout (columns, sorting, etc.) To
be able to reuse this report configuration the file can be saved for future use.

1. After the report has been modified, select Save Custom Report from the toolbar.

Save Custom Report x

Report Mame!

' Create public report

3 Create private report

==

2. Name the report and select Create Private Report.
3. Click OK.
4. The saved report is displayed under the Custom Reports tab.

™ Reports - Asure ID - B %
—o— : @
ﬁE Home Custom Reports L8
et
0
Data Felds for
Template - ABC Delta 1 =
Frivate Reports

Data Fields for Template - ABC_Delta

@ Diata Fald Nams Draka Figld Type Live Link Data Source Live Link Table Lrve Link Fald Is Key Feld

Yes o

Date

Text

Mumber

Text

Musmber

Text

Maumiber

Mumber
Emplayee_Photo Image =FOLDER = Employee_Fhoto
Employes Signature Image SFOLDERS Employee Signature

Text
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5.6 Export reports

Reports can be exported in the following file types:
= PDF
= XLS
= RTF

To export a report

1. One a report has been run. Select Export from the toolbar.

i Reports - Asure ID - B

x

E Home Custom Reports = l.év

3:| P+ User Actvity IE.H @ Records with no Photos ‘ : |_) i ) Ed @
u'.‘ﬁ Unprinted Records b @

User List 3 User Lagin All Records ; Template Print History || Template Data Fields | Refresh | Export JSave Custom
for & template 48} voided Records History Report List  for Template - Report
: Us_gr Repor_rs Da la_E_n_tr'g Repor_r_-: C._ard D_E_:slgn_ Ef.g_uorr_c Pata

2. Name and save the file.

The following example is a user record report exported to XLS (Excel file).

| ¥ User_List 5-5-15 [C
:m Hom: Insert Page Layoid Formubay Dats Raviaw VW Acrobat
I} = Tahoms B AN Em | P T Wrap Tedt Tast Bad ~am _‘r
Paste B s U- L -A- FEEE EHE SoMagehConters) § - 9 t Delete
| .
Il AL - S+ Al Records for 2 template - Template_1 -
[ A B c B £ F G H i i K L W N 5 P a =
i Afl Records for & template - Template_1
2 Evployesturber | PrintCount | PrntDste | PrintBy | Veided | Vod Dae Veid By Lwn.mm_mm_mm:&@um!mw'wm_wm Lw_m |, Card Jd Number
3 HID-10e 12 ] Uncheckad 1 Engreerng ane Dos (Picture} {Pense) 123455 DOE 3 12345 (] ]
& HID-boaler 13 Unchecked % fas0 ark e {Emary) ) "1z3481 s M 12306
& HID- MEvans 14 Undhecked 5 fan1 Mbe Euang [Empty) (Empty) "123506 EVANS M 12347
£ HID-¥Smith 15 Uincheckad 7 "0 Mary Smith [Ematy} [Ematy) "r23531 ST M 1234
T HID -HFiher 15 Uncheckad & [0 Helen Fisher {Emaity) {Emoty) "r23sss FISHER H 1239
§ HID-#R0ss 17 Unchackad % "0 Hen Ros (Emoty) (Empty) "23581 ROSS A 12350
G HID - SBecesl 18 Uincheckad ™ a0 Beb Bedsal {Emoty) (Emony) "123808 BRDSALL 5 12351
|| 40 HID - Racokowsls 19 Uncheckad T a0 Rab xelowsls  [Ematy) (et} "123631 KOLDWSKI R 12352
| 11 o -#omd 20 | Uncheckas T [s1m Paier Pl Ematy) {Emoty) "1238% PALL P 12353
| 12 HID-R# 21 Unchiechad s fa0 Rory il {Emty) (Emoty) "23a1 HILL & 12354
| 43 v -pe 22 | Uincheckad i fa0 Petar ol [Emety) (Emoty) "1z e amss
|| 14 HD-D3sbasen 23 Uncheckad fis "m0 Dave Jahnscn {Ematy} {TEmoty) "2z JOHMSON D 12356
|| 15 IHm-- AJanes 29 Uncheckad (i 400 |archie Jones {Emety) {Empty) "z3738 JONES A 12357
| 16 HID -FRarmar 25 Unchackad 7 "0 Fred Farmee {Emeity) (Empty) "z FARMERF 12338
17z Unchecked " 00 cardl Absion [Emoty) {Emoty) "33t ABELOU C 12360
Uncheckad ) "m0 Austin vadre  (Emoty) {Enoty) "3 HARDDE 1 12364
Unchacked i a0 Kathy ——— {Empty "123881 HALSTEAD X 13362
Unchatkad 22 300 Bruge Hoime Ematy) (Emmty) "izwm0s HOLMS B 12363
Unchecked s 120 Likan) Chanetts | Emoty) {Empty) " CHENETTEL 12364
Lincheckad 24 i Rebaces fiegs. (Emoty} (Empty) "1238% ROGS R 12365
Linchacked 25 00 Eric Euter [Emoty) {Empty) "123581 BUTLER E 12366
Unchecked % 20 ™ ke (Eroty) [Ety) 208 NELSEN B 12367
Unchecked 7 [0 = Jammeson | oty {Empty) aen JAMMESON 12368
| [A-459i | Sheet % [l p[

| | Resty | O]
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Section

6 iCLASS SE Encoder application

6.1 Overview

The iCLASS SE® Encoder application is used to encode HID Prox® and read/write applications onto smart
cards.

The following matrix illustrates the supported capabilities and card types.

Program HID Access Control Application Custom Data
Standard PACS SIO PACS Supported Key Types Standard SIo Supported
Application Application Application Application Key Types
v

HID Prox cards and N/A N/A N/A N/A N/A
fobs
iCLASS® v N/A Standard/Elite/Custom v
iCLASS SR v v Standard/Elite/Custom v
iCLASS SE N/A v Standard/Elite/Custom v
iCLASS Seos® N/A v Standard/Elite/Custom v
MIFARE Classic v P Standard/Elite*/Custom Py Coming Soon
(not Indala Flexsmart) *
MIFARE DESFire EV1 N/A v Standard/Elite*/Custom v

* Only supported for SIO PACS Applications

6.1.1 Credential credit management

All transactions are enabled by credential credits. These are individual credits that are used with every
transaction until there are none or until additional credits are ordered and applied to the encoder. For
information about ordering credentials, see the HID Global Credential Programmer How to Order Guide,
which can be found on www.hidglobal.com.
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6.2 iCLASS SE°® Encoder application modules

The iCLASS SE Encoder application contains three modules.

i Work Order Manager - iCLASS SE SG ONLY - Asure 1D - 8B X
™ ' MR E oy ; ;
@ [ New - e D 7 Edit B ) s Rangmtite Read Back
), Rename ] Export ta C5V e SN prenite selected
Open Close Print Add Work [ pemove AddRecord Add Batch @ card Info
() Delete ] Bt 1 POF || gty Lo Records  Execute Al @ cardin
Waork Crder Management Wark Instructions Wark Order Execution

oup by that column I :

Selected Encoder:
| 11 Home || Card_1d_nember | Faciity_Code | |CLASS_ Card_Serial,Number =
[©@cusssencer ) > [ 1@
- | Selected Technolagy:
j iCLASS
Wark Order Manager Current Status:
Disconnected
SAM Version:
Key Management M
l Credential Credits:
Reader Configuration
Work Order Descripti
| ) Advanced | Vor er iption

ICLASS: Write "H10301" {SE)

6.2.1 Work Order Manager module

The Work Order Manager module allows you to define and save an encoding profile for a credential
deployment. Each Work Order defines the number of data fields encoded, as well as the data type and field
size. These data fields are concatenated into a single data stream and encoded into an application, and are
defined by the selected format.

A Work Order is comprised of one or many Work Instructions. A Work Instructions is a single command
issued during work order execution. The single work instruction can either read or write to a specific memory
location.

6.2.2 Key Management module

The Key Management module of the iCLASS SE Encoder allows you to view and manage the HID and Custom
Keys. See the Asure ID Reference Guide, Section 7 iICLASS SE Encoder application (PLT-01797) module for
information on creating custom keys.

Note: Standard Keys and Key Sets are pre-loaded with the Encoder Configuration Package included on the
USB stick.
6.2.3 Reader Configuration module

The Reader Configuration window is used to create the Reader Data configuration cards (for both keys and
reader limited settings) The application allows you to change the keys or behavior of a Reader.
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6.3 Set up the iCLASS SE encoder

6.3.1 Load the configuration package

Initially you receive the Credential Credits and Keys either through a configuration package included on the
USB stick or in an email. To upload this package:

1. Select iCLASS SE Encoder application > Work Order Manager module > File tab > Upload
Configuration Package.

@ Install Plugin Package

Install Formats

-

I j Upload Encoder Configuration Package
_@. Import Work Grder

S S

2. Browse to locate the Configuration Package from HID.

] Upload Credential Credits

3. Select the file and click Open.

i Cpen
e
o9 [ | » Computer » CENTONUSE(F) » Credits and Keys v|¢,|| Search Credits and Keps o
Organize = Mew folder == - [ l@l
F Favorites Name Date modified Type Size
HID Global Credits.ise 2/97701511:53 Ahi ISE File 43 KB
i Libraries || SN_CP0414(S011101293771 ) .ise 11/5/2014 1:26 PM ISEFile 28|
M Computer
File name: SN_CP0414(S011101293771).ise +  |iCLASS SE Encoder Filles (“ise) = |

I Open | Cancel |
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4. A confirmation message is displayed at the bottom of the window and the Credential Credits are
displayed in the Configuration pane.

Note: Keys may also be loaded, depending on what was ordered.

i Work Order Manager - Asure ID =

Ej Cea _uh‘ ;ﬂb

AddWork [ gemove |/ cord AddE : - P cadinfo
Instruction

Wiark Instructions Work Order Execufion

»
@& =

Selected Encoder:
|9M§m - | HID C8DEY 5427 CKSC0 - 9
Selectad Technology:
Q LR
ok Oridar Manager Current Status:
: Connacted

SAM Version:
Key Management 4.0.0.0

. Credential Credits:

Gernane HID, iCLASS Elite
Reader Configurabon 100

Genune HID
| U Advanced | P
Genume HID, iCLASS Elite, HID 510
100
Genung HID, HID 510
135
Key Ralling
)
Gernine HID, Custom
136

Work Order Desoription

Packags has been successfully instaled,

6.3.2 Install format

The iCLASS SE Encoder includes a format interpreter capable of parsing all open and custom formats
developed and maintained by HID Global.

Format fields are presented to you in the desktop Ul for the purpose of assigning data to each field.

Formats must be ordered from Customer Service. Most formats are custom to a specific OEM or end user, and
are not freely distributed.

The H10301 is the default format delivered with the application.

To use a format other than the provided default format.

1. Select ICLASS SE Encoder application > Work Order Manager module > File tab > Install Formats.

2. Browse to locate the Format file from HID. Select the file and click Open.

3. After the format is successfully loaded, the new format is displayed as an option when creating a Work

Order.
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6.3.3 Create a work order

A Work Order is comprised of one or many Work Instructions. A Work Instruction is a single command
issued during work order execution. The single work instruction can either read or write to a specific memory
location.

See Section 6.4 Use case 1. deploy standard security credentials or Section 6.5 Use case 2: deploy HID Prox
credentials for two common Use Case scenarios. For detail information on all Work Order configurations, see
the Asure ID Reference Guide.

6.4 Use case 1: deploy standard security credentials

This use case addresses the deployment of the legacy HID Access Control Application on iCLASS credentials.
This application is the predominant application in use in the market for the last decade. The use case also
addresses the lesser used legacy HID MIFARE application.

Note: The procedures in this use case assume readers are already configured with standard security keys for
iCLASS and MIFARE SIO and have the iCLASS and MIFARE SIO data model interpreters.

Note: For more detailed information, see the Asure ID Reference Manual.

6.4.1 Create a work order to encode iCLASS credentials
Create a new work order for iCLASS credentials

Creating a new work order begins the definition of a work instruction through a technology specific wizard
plugin exposing many user selectable options.

1. Select iICLASS SE Encoder application > Work Order Manager module > New.
2. Select the iCLASS plugin and click OK.

iy
Home
3 el

Open  Close

(¥ Delete

[ Hew
) Rename = e

'v';qu Crder Management

Work Grder Manager

Key Management

Reader Configuration

| J Advanced

4 Record 0 of O

Work Order Manager - Asure ID

] = Edit

B Add Work [ Remave
iadl] Instruction
Work Instructions

MIFARE DESFire EV1

Fraox
Seos

OK ( Cancel |

Ready

September 2018

= ™
e
|
: @ card info
Wark Crder Execution
Selected Encoder:
HID OMMNIKEY 5127 CK SC© - &
Selected Technology:
iCLASS
Current Status:
Disconnacted
SAM Version:
MiA
Credential Credits:
Genuine HID, ICLASS Elite -~
- |
Genuing HID
58
Genuine HID , ICLASS Elite, HID SI0 8
Work Crder Description
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3. The iCLASS Encoding wizard opens. Click Next.
=TT

Welcome

This wizard will assist you in configuring @ work order instruction for encoding to iCLASS

iCLASS

To continue, dick Next

Cancel |

4. Set the options on the Select data format page. This page shows options to set up the instruction.
In this use case we are selecting:
= Instruction Type: Write
= Data Type: HID Access Application
= Options: No selection
= Credential Type: HID Access Application
= Format: H10301

e e

Select data format
Select the format of the data that will be written to the card,

Instruction Type Credential Type
1 5E (50 only)

") Read

1 Roll Card Authentication Key Format:
l H10301 l Add
Data Type

I 120 HID Access Application I
~ | Custom

Options If the format you are trying to read is not listed here,
contact your HID representative for assistance.

[C] Owerwrite Existing Credential

|C1 Enable User PIN Entry

< Back I| Mext = |I | Cancel
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5. Set the options on the Define Format Parameters page.

This page exposes options to customize the selected format. In this use case we are seeing the details
of the H10301 format, which is the open, 26-bit SIA Wiegand format.
' iCLASS Encoding =

Define Format Parameters
Define format parameter specifics,

Mame Parameter Type Enforce Unique ... | Default Yalue Increment Step Auto Number Ra...

Facility Code Static [} 1 1| 1-255

el Card 1d Mumber

[ Auto Tncrement
| Static

| Manual User Entry | :
=] | < Back |I MNext = I | Cancel |
Field/Column Description
Name The name field displays the names of the format parameters as assigned by HID. It is

strongly recommended to leave these names as they are.

Parameter Type This field identifies the rules regarding how the value of a parameter is derived.
These are read from the format file and there is typically no need to change.

Static This parameter type means every encoded credential has the value of the Default
Value field for that parameter.

Manual User Entry This parameter type starts with the value of the Default Value field and allows you
to enter a new number.

Enforce Unique Numbers | This field ensures that a number can never be repeated. For best practice, it is
recommended to keep this checked for the Card ID Number.

Default Value This field only has meaning for the Static and Manual User Entry parameter types.
Auto Increment parameter type uses the Auto Number Range field.

Increment Step This field determines the step for format parameters that are of the Auto Increment
parameter type.

Auto Number Range This field shows the allowable numbers that can be encoded for Auto Increment
parameter Types. In the case of the H10301 format, the Card ID Number is open and
untracked. This means all numbers for that parameter (16-bit number) are available.
However, all Corporate 1k, proprietary, and open-managed formats have a Card ID
parameter with a number range set in the format file that is determined when
ordering the format.

6. Set the options on the Memory Map Configuration page.

September 2018 75



iCLASS SE Encoder application PLT-01485, Rev. 2.5

This page shows options to set the memory configuration of the iCLASS card.

icLass Encoding = e -
Memory Map Configuration

Select card configuration and location where data will be written

Expected Card Type:

Configured iw

Card Configuration;

| < Badk m MNext = il| Cancel |

Typically, encoding of iCLASS credentials is done with pre-configured credentials from HID (2k, 16x2k,
etc.). In which case, the Expected Card Type is Configured and there are no further selections to make.

In some rare use cases, the encoder can be used to configure a virgin iCLASS credential. In this case the
Expected Card Type is set to Unconfigured and the Card Configuration must be selected from the
supported list and match the credential type used.

7. Set the options on the Key Selection page.

This page exposes options to select the media keys used to authenticate with the HID Application on
the iCLASS credential.

icLASS Enceding [ e .

Key Selection
Select a key which will be used to lock the AppArea after the data is written,

Keys
Card Authentication Key:
Standard -

| < Back

In this use case we are using Standard security media keys. Elite or Custom media keys (if they are
loaded) are also selectable at this step.

8. Finish the wizard and save the Work Order.
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6.4.2 Encode iCLASS credentials

1. When the work instruction(s) are executed, a message displays at the window bottom, the credential
serial number displays in the main pane, and a new record becomes available for execution.

2. Open the iCLASS work order to encode from. Select Open from the toolbar, and select the Work Order
from the list.

The work order table view shows the first credential ready to be encoded with a Card ID Number value
of 1and a Facility Code of 1.

Work Order Manager - Use_Case 1 Work_Order - Asure ID - B X

Hame % &
', TR - — —

&9 [ New T B saveas e E‘;@ }}@ % ‘ ‘ . iiaasadil
&) Rename ] Export to CSv : A & i J J

e Primt Add Work [ pemove AddRecord AddBatch Remove Execute Execute (B card Info
() Delzte {#%| Expart ta POF || [nstruction F. Records Records Selected Al ©®

Wark Crder Management Wark Instructions \Wark Order Execufion

calumn header here to oroup by that column

Sebcted Encoder:

HID OMMNIKEY 5127 CK.SC O -3 E_J
Selected Technology:

iCLASS

Card_Id_Number Fadiiity_Code | CLASS Card_Serial_N...

Work Order Manager Current Status:
Connected

SAM Version:
Key Management 5.3.0.0

. Credential Credits:

| Genuine HID, ICLASS Elite A
Reader Configuration .

30
| || Genuine HID I
| i) Advanced | e |
| Genuine HID, iCLASS Elite, HID 510
0
[ e sime WTEY T ST

Work Order Description
ICLASS: Write "H10301" (SE)

Ready

In this case, the selected format for the work order is HIO301. The Facility Code is a static parameter
and we set a default of 1in the Work Instruction wizard. Every credential is encoded with the value of 1

for this parameter. The Card ID Number is Auto Increment and increases by one every time a credential
is encoded.

3. Select the record and select Execute Selected from the toolbar.

4. A status window provides feedback on the progress of the encoding operation.
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5. After the encoding operation is complete, the work order table view is updated with the Card Serial
Number and a new record is created with the next Card ID Number.

i Work Order Manager - Use_Case 1 Work_Order - Asure ID - B X

G B, D B 8 B|E]3 e

Open Close Print Add Work [T Remove AddRecord AddBatch Removel Execute Execute [ Card Info
() Delete %] Export to POF || tnstruictin [ Records Records Selected | Al
Work Orier Maogament ek Tresbicont . Wk Crer Bosen e

Card_Id_Number Fadlity Code i CLASS Card_Serial_Mumber

| i Home 1> I 1| 38sD440178FF 1260 Selected Encader:
2 1 HID OMNIKEY 5127€KSCD - | &)
| © iCLASS SE Encoder I |
Zelected Technology:
| ; iCLASS b
Work Order Manager Current Status:
(Connected
SAM Yersion:
Key Management 5.3.0.0
. Credential Credits:
| Genuine HID, iCLASS Elite A
Reader Configuration i 20 '
| || Genuine HID I
| L Kt | | &8 [
Genuine HID, ICLASS Elite, HID 510
30

:."_""."" sim e T l:J'IT'\ {3 a
Work Order Desgiption
ICLASS: Write "H10301" (SE)

Ready
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6.4.3 Create a work order to encode MIFARE classic credentials
Create a new work order for MIFARE classic credentials

1. Select iCLASS SE Encoder application > Work Order Manager module > New.
2. Select the MIFARE Classic plugin and click OK.

iin Work Order Manager - Asure ID - B X
.___.._
Haome 2 g
_‘ N ) == g 5
- @m e |
#, Rename t i = = E -
Close Add Work [T pemeve | A0 R g Card Info
@ Delete |r$ | t F || Instruction L' fg X A @
INorie e Wanagnenk Work Ieiictions JOR Dxden Excofon.

I ‘Brag mhﬂh here to group by that column

| fip Home | | Selected Encoder:
|eiCLASSSEE i HIZ OMMNIKEY 5127 CK 5C 0 - U
e selected Technology:
| ; iCLASS o
YWork Order Manager Current Status:
Discannacted
SAM Version:
Key Management A
I F ok | | Cancel Credential Credits: -
Genuine HID, iCLASS Elite -
Reader Configuration 0 =]
| Genuine HID
| £ Advanced | —
[P

Work Order Description

Creating a new work order begins the definition of one work instruction through a technology specific
wizard plugin exposing many user selectable options.

3. The MIFARE Classic Encoding wizard opens. Click Next.

' MIFARE Encoding
Welcome

This wizard will assist you in configuring & work order instruction for encoding to MIFARE

To continue, dick Next
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4. Set the options on the Select Data Format page.

This page exposes options to set up the instruction. In this use case we are selecting:

= |nstruction Type: Write

= Data Type: HID Access Application

= Options: No selection

= Credential Type: HID Access Application
= Format: H10301

MIFARE Encoding

Select data format
Select the format of the data that will be written to the card,

Credential Type
11 5E {50 only)

Instruction Type

" Read

" Roll Card Authentication Key

71 Move Genuine 50 Sector

Diata Type

I 1 HID Access Application I
I~ Custom

Options

[T Owerwrite Existing Credential

! < Back

S
'| Mext =

=)

If the format you are trying to read is not listed here,
contact your HID representative for assistance.

l ! Cancel |

iCLASS SE Encoder application PLT-01485, Rev. 2.5

5. Set the options on the Define Format Parameters page. See Section 6.4.1 Create a work order to

encode iCLASS credentials, Step 5.

MIFARE Encoding

Define Format Parameters
Configure format parameters data field names, value unigueness, number ranges and auto-incrementing

bl Card 1d Mumber

[Auto Incement
| Static
| Manual User Entry

behavior,
MName Parameter Type Enforce Unique ... | Default Value Increment Step Al
Fadility Code Static ] . & 1{1-255

=)

to Mumber Ra... ]

.

< Back Mext =

|l | Cancel

80
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6. Click Next on the Key Selection page.

Note: Sector number and keys used for authentication are fixed and not selectable.
7. Finish the wizard and save the instruction profile.

6.4.4 Encode MIFARE credentials

1. When the work instruction(s) are executed, a message displays at the window bottom, the card serial

number displays in the main pane, and a new record becomes available for execution.

2. Open the MIFARE Classic work order to encode from. Select Open from the toolbar, and select the
Work Order from the list.

The work order table view shows the first credential ready to be encoded with a Card ID Number value
of 1 and a Facility Code of 1.

i Work Order Manager - Use_Case_1_Work_Order Mifare - Asure ID - B X

Home % "t?-"
- — T = — T—
@ " B e _ Edit E—@ e B ‘ ‘ ‘ i * ReadBack |
) Rename | Export ta C5V 4 b b= %3!}

Open | Close _ Print Add Work [7] pemove || AddRecord AddBatch Remove Execste Exeaute (@) Card Info
) Delete {#h| Export to PEF || traruction r Records Records Selected Al

for: e aoaesiies Work Jetniciions Yo D er eat ot

calumn header hiere to group by that column

| Mo Home Card_ld_Mumber | Facility_Cade MIFARE_Classic_Card_Serial_Mumber i etias ey o
I\emSlEEEE y 1 S451 HID OMMNIKEY 5127 CK'SC D L ]
== Selected Technology:
B - - = MIFARE Classic ¢
Work Qrder Manager Current Status:
' Connected
SAM Yersion:
Key Managament 5.3.0.0
I Credential Credits:
| Key Ralling -
Reader Configurabon 10 H
Third Party, Custom |
| £ Advanced e

| Geruine HID, Custom
3

| Third Roetu L0 ETO | ™ |
Work Order Description
MIFARE Classic: Write "H10301" (HID)

Operation cancelled by i=er,

In this case, the selected format for the work order is HI0301. The Facility Code is a static parameter
and we set a default of 1in the Work Instruction wizard. Every credential is encoded with the value of 1
for this parameter. The Card ID Number is Auto Increment and increases by one every time a credential
is encoded. Select the record and select Execute Selected from the toolbar.

3. A status window provides feedback on the progress of the encoding operation.
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. After the encoding operation is complete, the work order table view is updated with the Card Serial
Number and a new record is created with the next Card ID Number.

[ Work Order Manager - Use_Case_1_Work_Order_Mifare - Asure ID - B X
ER - . @
e R o Save As = '. | .
I P yli= B = B D W P
) Rename {8 Export ta C5V =
Open Close Print Add Work [ pemoye | Add Record Add Batch Removel] Execute Execute .@ Card Info
@ Delete {#] Export to POF || Inetruction 3 Records  Records] Selected | Al
o riies Mameamenie i AVor BN UCe, Wk Cyoer Eeos
|_l.. m Card_Id_MNumber Fadility_Cade B - i I y
|9M$E i HID OMMNIKEY 5127 CKSCD - u
et — ] Selected Technology:
| ; MIFARE Classic -
Work Crder Manager Current Status:
\Connacted
= SAM Yersion:
Key Management 5.3.0.0
l Credential Credits:
Key Rolling |
Reader Configuration i 2'9 ,
| Third Party, Custom |
| €3 advanced I L
| Genuine HID, Custam
30
[ Third Harbe_n ETO il
Work QOrder Description
MIFARE Classic: Write "H10301" (HID)
Operation cancelled by user,
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6.5 Use case 2: deploy HID Prox credentials

This use case addresses the deployment of HID Prox cards and fobs.

6.5.1 Create a work order to encode HID Prox credentials

1. Select ICLASS SE Encoder application > Work Order Manager module > New.
2. Select the Prox plugin and click OK.

e Work Order Manager - Asure ID - B
————
H L
e } = D —
Edit o ; = .
4 ! 3% ot z&'
Open Close i Add Work [ pemave 4000 Rt E =Ll ¥ card Info
(;j Delete ] Esxciert to POF || Tnstruction 4 I k 1 ®
Work Crder Management Wark Instructions Wark Order Execufion
| {ip Home Selected Encoder:
| eiCLASSSEE " : . . . HID OMMIKEY 5127 CK.SC O - &)
—— Select a Plugin [eE30] Selected Technolagy:
2 ; {CLASS iCLASS
Work Qrder Manager MIFARE Classic Current Status:
: ! Connscted
SAM Version:
205
Key Management 5.3.0.0
. | ok !| | S | Credential Credits:
| Genuine HID, ICLASS Elite -
Reader Configuration 0 |
| | Genuine HID I
| € Advanced | | &5 '
Genuine HID, iCLASS Elite, HID 510
30
|Lmmine i memn fudl|
Work Order Description
Cperation cancelled by user,

Creating a new work order begins the definition of a work instruction through a technology specific

wizard plugin exposing many user selectable options.
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3. The Prox Encoding wizard opens. Click Next.

F Prox Encoding ;

Welcome

This wizard will assist you in configuring & work order instruction for encoding to Prox

PREX BY
HEID

To continue, dick Mext

Cancel

4. Set the options on the Select Data Format page.

This page exposes options to set up the instruction. In this use case we are selecting the H10301 as the
Format.

In this use case we are selecting:
= |nstruction Type: Write
= Options: No selection
= Format: H10301

. Prox Encoding

Select data format
Select the format of the data that will be written to the card,

Instruction Type Credential Type
" Read

=5 i

Options

[ verwrite Existing Credential

If the format you are trying to read is not listed here,
contact your HID representative for assistance.

| < Back I| Mext = | Cancel |

5. Set the options on the Define Format Parameters page. See Section 6.4.1 Create a work order to
encode iCLASS credentials, Step 5.
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This page exposes options to customize the selected format. In this use case we are seeing the details
of the H10301 format, which is the open, 26-bit SIA Wiegand format.

- Prox Encoding

Define Format Parameters

Configure format parameter data field names, value unigueness, number ranges and auto-ncrementing
behavior,

. _ -
Mame Parameter Type Enforce Unique ... | Default value Increment Step Auto Number Ra...
Fadlity Code

.

| < Back | Mext = |I| Cancel

6. Finish the wizard and save the instruction profile.
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6.5.2 Encode HID Prox credentials

1. Open the Prox work order to encode from. Select Open from the toolbar, and select the Work Order

from the list.

PLT-01485, Rev. 2.5

The work order table view shows the first credential ready to be encoded with a Card ID Number value
of 1 and a Facility Code of 1.

iin Work Order Manager - Asure 1D - B X
Home e
' SR = Save As = e —
L e o) Bl s ! Edit k o R | ‘ : Read Back | |
i B ®§ 8
& Rerame [ Export ta C5V = e =
Open | Close Print Add Work |1 pemave | Add Record AddBatch Remove Execute Execute [ card Info
\lzﬁ Delete m.' Expert 1o PDF || [netriction L' Records Records Selected Al @
b S8 B el Work Insinicions Sule O s i aonl)
EWB aﬂilm!mdér"h&atn aroup by that column _
| r!Hm"E Card_Id_Number | Facility_Cade | Prox_Card_Serial_Mumber o Enu?der: o
L@MESEE " HID OMNIKEY 5127 CK'SC D - |y
— Selected Technology:
; Prox v
Work Order Manager Current Status:
Disconnected
SAM Yersion:
Key Management INfA
. Credential Credits:
Genuine HID
Reader Configurabion lss
| € Advanced
T Ik \Work Order Description
Prax: Write "H10301" (HID)

In this case, the selected format for the work order is HI0301. The Facility Code is a static parameter and
we set a default of 1in the Work Instruction wizard. Every card is encoded with the value of 1 for this
parameter. The Card ID Number is Auto Increment and increases by one every time a card is encoded.

2. Select the record and select Execute Selected from the toolbar.

3. A status window provides feedback on the progress of the encoding operation.
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4. After the encoding operation is complete, the work order table view is updated with the Card Serial
Number and a new record is created with the next Card ID Number.

D Work Order Manager - Asure 1D - B x
Ea - @
@ [ Neaw 1 [ saveas B - E | ‘: [3
- = ' Exit =¥ - - Read Back
R i et B B Bl
Open Close Print Add Work Remove | AddRecord AddBatch Remove] Execute FExecute Card Info
& pelete ] Export o POF || fnstruction F Records  Records{Selectsd J Al ©®
S0 Oocley: Mgy Mok Insiciions

Wark Order Execution

- Sélecteci Enco&er:

HID OMNIKEY 5127 CK 5C 0 L]
Selected Technology:
|| |Prox -

Work Order Manager Current Status:
Disconnectad
SAM Version:

Key Management A
. Credential Credits:

| Genuine HID

Reader Configuration 162

| i
| € Advanced =

Work Order Description
Prox: Write 'H10301" (HID
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Section

7 Advanced application

The Advanced Application is used to manage Users and Laser Printer configurations.

Note: This section covers the basics of the User Config module. For detailed information on the entire
Advanced Application, see the Asure ID Reference Guide.

I - @
=NalF 2 2 o
= - - -t
Cut Copy Paste | AddUser Remove Save Users Change Manage Assign Template
User Password | Group to Group
Cliphaard Asure 1D Users Password Group Management
e - MainView
| e ]
== CLASE SE Encoder | Record 1of2 & Record 2af 2 2
1) Advanced ] Uiser ID: admin User 1D: Tooe
2 Name: Administrator Name: John Doe
£ Lise Windows Authentication: El Use Windows Authentication: |
User Config Group Mame: Mone Group Mame: MHone
Card Design: =] Card Design: I
= Card Printing: & Card Frinting: 7l
Laser Config Liser Config: = User Config: &
Reports: il Reports: ]
Laser Engraving: 7l Laser Engraving: ¥
Program Options: il Program Options: ]
Data Entry: Read/Write Access (with PACS) Data Entry: Fead\Write Access (with PACS)
m iCLASS 5E: Administrator ICLASS SE: Administrator
| =
Ei=
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7.1 User config module

With the Data Entry application, the Asure ID admin user imports/enters the user information. The Advanced
Application allows the Asure ID admin to manage these records.

See Section 4 Data Entry application for detailed information.

—

=4
[ W "%l-| ? ? c? r:) ~J
g5 & & <4 - -
Cut Copy Paste | AddUser Remove -Savelsers Change Manage Assign Template
Uiser Password Group to Group
Clipboard Asure ID Users Passwiord Group Manazement

7.1.1 Add a user
1. Select the Advanced application > User Config module > Home tab > Add User.
2. Enter the user information in the blank record.
Note: Fields become active when the cursor is passed over them.

3. Select the options for this user to have access to. In this example Card Design, Card Printing, and
Reports have been selected.

4. In the Data Entry drop-down list, select Read/Write Access (no PACS).
5. In the iCLASS SE drop-down list, select Operator.

6. Select Save Users from the toolbar. This saves all users that have been modified.

Home View 2 @
W ! _— -'.’ - 5
. - 2
& ]l & & <& < |
Cut Copy Paste | AddUssq Remove Save Lisers Change 2
User Pazsword
Cliphoard Asure 1D Lisars Passward | fGr..
MainView
| i Fome |
| TF= iCLASS SE Encader [ —— 2
e 2 MName:
- Use Windows Authentication:
User Config Group Name: Mane
Card Design: &)
—. -
—— Card Printing: [&
Laser Canfig User Config: 8
Reports: &
Laser Engraving: i
Program Opbons: _
Data Entry: Read/Write Access [with PACS)
m — =

90 September 2018



PLT-01485, Rev. 2.5 Advanced application

7.1.2 Modify and save a user
1. Select the Advanced application > User Config module > Home tab.
2. Select and modify one or more users as needed.

3. Select Save Users from the toolbar. This saves all users that have been modified.

Home View 2 .Q.
G T
b 00 S S| & : |
Cut Copy Paste | Add User Removel Save Lisers Change 2
User Password
Cliphoard Asure ID Lisers Password | |Gr..
] e MainView
| i Fome |
| "Z iCLASS SE Encader | Newuser 2
! U.."f‘?‘_’_ﬂ_’.‘?" | User ID: Jane Doe
~ 2 Iame:
= Use Windows Authentication:
User Config Group Mame: Mane
Card Design; [
—a e
— Card Printing: [
Laser Config User Config: |
Reparts: [
Laser Engraving: |
Program Options: __
Data Entry: FeadWrite Access [with PACS)
m JCLASS SE; Operator ~ ;

7.1.3 Remove a user
1. Select the Advanced application > User Config module > Home tab.
2. Select a user.

3. Select Remove User from the toolbar, and click Yes to confirm.
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7.1.4 Change a user password

—_

Select a user record.

2. Select Change Password from the toolbar.
3. In the pop-up dialog box, type in the new password and confirm.
4. Click OK.
E Home View
7] = 3 -3 ~ r.) ~)
& E & & &a & &
Cut Copy Paste | AddUser Remove SavelUsers Change Manage Assign Template
User Password Group to Group
Clipboard Asure ID U=ers Password Group Management

Change User Password

Mew Password:
(L L1 ]]
Confirm Password:

Ok, | | Cancel

7.1.5 Add a user group
1. Select the Advanced application > User Config module > Home tab > Manage Group.
2. In the Manage Group window, select the Add User Group icon.
3. Enter the group information in the blank record.
Note: The field becomes active when the cursor is passed over it.

4. Select the options for this group to have access to. In this example Card Design, Card Printing, and
Reports are selected.

5. In the Data Entry drop-down list, select Read/Write Access (no PACS).
6. In the iICLASS SE drop-down list, select Operator.
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7. Select the Save icon. This saves the user group.
E Home View

] b [ o ] - | &

| P& & & &L

Cut Copy Paste | AddUser Remove Save Lisers Change Manage §ssign Template

User Password Group to Group
Clipboard Asura ID Users Password Group Mana_gement
Manage"[%roup

Operator PACS

5 |

MName: Operator Mo PACS
Card Design: &
Card Printing: I
User Config:
Reports:

Laser Engraving:
Program Options: =

Data Entry: Read/Write Access (no PACS)
HCLASS SE: Operator = |
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7.1.6 Delete a user group
1. Select the Advanced application > User Config module > Home tab > Manage Group.
2. In the Manage Group window, select the group to delete and select the Delete Group icon.

3. In the Warning pop-up dialog box, click Yes to delete the user group.

EHGNE View
tBDAd & = (2]

Cut Copy Paste @ AddUser Remove Save Users Change Manage §ssign Template

User Password Group to Group
Clipboard Asura ID Users Passwiord Group Management
Manage Group

Operator Mo PACS

b

Mame: Operator Mo PACS
Card Design: &
Card Printing: ]
User Config: ]
Reports: =

Laser Engraving: [T
Program Options:

Data Entry: Read/Write Access {no PACS)
ICLASS SE: Operator
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7.1.7 Assign a template to a group

1. Select the Advanced application > User Config module > Home tab > Assign Template to Group.

2. In the Assign Template To Group window, select the group to assign the template to. In this example,

Operator PACS.

3. Select the template type to filter (card templates, work orders or all). In this example Asure ID Card

Template is selected.

4. Click the arrow key to move the selected Available Template column to the Assign Template column.

View

—

& T A R &2 o
35 & e = -
Cut Copy Paste | AddUser Remove Save lgers Change Manage
User Password Group
Clipboard Aszurs ID Users Password Group Management
Assign Template To Group

Select Group: | Operator PACS

Filter:  Asure ID Card Template

Available Template

MountainView_1

Template_2

Assign Template

Template_1
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